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Preface

Read This First

About This Manual

This manual describes DSP/BIOS 5.41, which may have been installed as
part of the Code Composer Studio v3 or v4 installation. Separate installers for
DSP/BIOS 5.41 provide support for use within CCSv4 and CCSv3.3.

DSP/BIOS gives developers of mainstream applications on Texas
Instruments TMS320 DSP devices the ability to develop embedded real-time
software. DSP/BIOS provides a small firmware real-time library and easy-to-
use tools for real-time tracing and analysis.

You should read and become familiar with the TMS320 DSP/BIOS API
Reference Guide for your platform. The API reference guide is a companion
volume to this user’s guide.

Notational Conventions

This document uses the following conventions:

[ Program listings, code examples, and interactive displays are shown in a
special typeface. Examples use a bold version of the special
typeface for emphasis; interactive displays use a bold version of the
special typeface to distinguish commands that you enter from items that
the system displays (such as prompts, command output, error
messages, etc.).

Here is a sample program listing:

Void copy (HST Obj *input, HST Obj *output)

{

PIP_Obj *in, *out;
Uns *src, *dst;
Uns size;

}

[ Square brackets ([ and ]) identify an optional parameter. If you use an
optional parameter, you specify the information within the brackets.



Related Documentation From Texas Instruments

Unless the square brackets are in a bold typeface, do not enter the
brackets themselves.

@ Throughout this manual, 64 can represent the two-digit numeric
appropriate to your specific DSP platform. If your DSP platform is C62x
based, substitute 62 each time you see the designation 64. For example,
DSP/BIOS assembly language API header files for the C6000 platform
will have a suffix of .h62. For the C2800 platform, the suffix will be .h28.
For a C64x, C55x, or C28x DSP platform, substitute 64, 55, or 28 for each
occurrence of 64. Also, each reference to Code Composer Studio C5000
can be substituted with Code Composer Studio C6000 depending on
your DSP platform.

[ Information specific to a particular device is designated with one of the
following icons:

Related Documentation From Texas Instruments

The following sources describe TMS320 devices and related support tools.
To obtain a copy of any of these Tl documents, visit the Texas Instruments
website at www.ti.com.

TMS320C28x DSP/BIOS API Reference (literature number SPRU625)

TMS320C5000 DSP/BIOS API Reference (literature number SPRU404)

TMS320C6000 DSP/BIOS API Reference (literature number SPRU403)
describes the DSP/BIOS API functions, which are alphabetized by name. The
API Reference Guide is the companion to this user’s guide.

DSP/BIOS Textual Configuration (Tconf) User’'s Guide (literature number
SPRUO0O07) describes the scripting language used to configure DSP/BIOS ap-
plications.

DSP/BIOS Driver Developer's Guide (literature number SPRU616)
describes the IOM model for device driver development and integration into
DSP/BIOS applications.

RTSC-Pedia wiki: http://rtsc.eclipse.org/docs-tip/Main_Page

Code Composer Studio Online Help provides information about Code Compos-
er Studio.

Code Composer Studio Mediawiki:
http://tiexpressdsp.com/wiki/index.php?tite=CCSv4



Related Documentation From Texas Instruments

TMS320C2000 Assembly Language Tools User's Guide (SPRU513)

TMS320C55x Assembly Language Tools User’s Guide (SPRU280)

TMS320C6000 Assembly Language Tools User's Guide (SPRU186)
describes the assembly language tools (assembler, linker, and other tools
used to develop assembly language code), assembler directives, macros,
common object file format, and symbolic debugging directives for the C5000
generation of devices.

TMS320C2000 Optimizing C/C++ Compiler User's Guide (literature number
SPRU514) describes the C2000 C/C++ compiler and the assembly optimizer.
This C/C++ compiler accepts ANSI standard C/C++ source code and produc-
es assembly language source code for the C2000 generation of devices. The
assembly optimizer helps you optimize your assembly code.

TMS320C55x Optimizing C Compiler User’'s Guide (literature number
SPRUZ281) describes the C55x C compiler. This C compiler accepts ANSI
standard C source code and produces TMS320 assembly language source
code for the C55x generation of devices.

TMS320C6000 Optimizing C Compiler User's Guide (literature number
SPRU187) describes the C6000 C/C++ compiler and the assembly optimizer.
This C/C++ compiler accepts ANSI standard C/C++ source code and produc-
es assembly language source code for the C6000 generation of devices. The
assembly optimizer helps you optimize your assembly code.

TMS320C55x Programmer's Guide (literature number SPRU376) describes
ways to optimize C and assembly code for the TMS320C55x DSPs and
includes application program examples.

TMS320C6000 Programmer's Guide (literature number SPRU189) describes
the C6000 CPU architecture, instruction set, pipeline, and interrupts for these
digital signal processors.

TMS320C6000 Peripherals Reference Guide (literature number SPRU190)
describes common peripherals available on the TMS320C6000 family of
digital signal processors. This book includes information on the internal data
and program memories, the external memory interface (EMIF), the host port,
multichannel buffered serial ports, direct memory access (DMA), clocking and
phase-locked loop (PLL), and the power-down modes.

TMS320C28x DSP CPU and Instruction Reference Guide (literature number
SPRU430).
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Related Documentation

Trademarks

vi

You can use the following books to supplement this reference guide:

The C Programming Language (second edition), by Brian W. Kernighan
and Dennis M. Ritchie, published by Prentice-Hall, Englewood Cliffs, New
Jersey, 1988

Programming in C, Kochan, Steve G., Hayden Book Company

Programming Embedded Systems in C and C++, by Michael Barr, Andy
Oram (Editor), published by O'Reilly & Associates; ISBN: 1565923545,
February 1999

Real-Time Systems, by Jane W. S. Liu, published by Prentice Hall; ISBN:
013099651, June 2000

Principles of Concurrent and Distributed Programming (Prentice Hall
International Series in Computer Science), by M. Ben-Ari, published by
Prentice Hall; ISBN: 013711821X, May 1990

American National Standard for Information Systems-Programming
Language C X3.159-1989, American National Standards Institute (ANSI
standard for C); (out of print)

MS-DOS, Windows, and Windows NT are trademarks of Microsoft
Corporation.

The Texas Instruments logo and Texas Instruments are registered
trademarks of Texas Instruments. Trademarks of Texas Instruments include:
Tl, XDS, Code Composer, Code Composer Studio, Probe Point, Code
Explorer, DSP/BIOS, RTDX, Online DSP Lab, BIOSuite, SPOX, TMS320,
TMS320C54x, TMS320C55%x, TMS320C62x, TMS320C64x, TMS320C67X,
TMS320C28x, TMS320C5000, TMS320C6000 and TMS320C2000.

All other brand or product names are trademarks or registered trademarks of
their respective companies or organizations.

August 26, 2009



Contents

1 ADBOULt DSP/BIOS .. it 1-1
DSP/BIOS is a scalable real-time kernel. It is designed to be used by applications that require real-
time scheduling and synchronization, host-to-target communication, or real-time instrumentation.
DSP/BIOS provides preemptive multi-threading, hardware abstraction, real-time analysis, and
configuration tools.

1.1 DSP/BIOS Features and Benefits . ......... . . 1-2
1.2 DSP/BIOS COMPONENTS . . . o oottt et e et e e e e 1-4
1.3 Naming ConVeNtioNS . ... ... o e 1-9
1.4 For More Information . .. ... .. . 1-14
2 Program Generation ... ... .. e 2-1

This chapter describes the process of generating programs with DSP/BIOS. It also explains which
files are generated by DSP/BIOS components and how they are used.

2.1 Creating and Building a CCSv4 Project for DSP/BIOS Applications ............... 2-2
2.2 Converting CCSv3.3 Projectsto CCSv4 Projects . ......... . i, 2-10
2.3 Configuring DSP/BIOS Applications Statically . . .. ........... ... ... ... .... 2-11
2.4 Creating DSP/BIOS Objects Dynamically ........... ... ... . .. .. 2-16
25 Files Used to Create DSP/BIOS Programs . ...ttt 2-18
2.6 Using Makefiles to Build Applications. . ... ... ... . i i 2-20
2.7 Using DSP/BIOS with the Run-Time Support Library. . . ....................... 2-22
2.8 DSP/BIOS Startup SEQUENCE. . . . . vttt et e e 2-24
2.9 Using C++ With DSP/BIOS . . . ... oo e e e 2-28
2.10 User Functions Called by DSP/BIOS . . ... ... i e e 2-31
2.11 Calling DSP/BIOS APIsfrom Main. . ... ...t 2-32
3 INStrUMeENtatioN ... ... 3-1

DSP/BIOS provides both explicit and implicit ways to perform real-time program analysis. These
mechanisms are designed to have minimal impact on the application’s real-time performance.

3.1 An Overview of Real-Time AnalysiS. . .. ... e e e 3-2
3.2 Real-Time Analysis Tools in CCStudio V3.X. . . ..o oot e 3-3
3.3 Kernel Object VIEW IN CCS V3. X. . vttt et e ettt e e 3-13
3.4 Real-Time Analysis Tools in CCStudio VA.X. . . . ..ot 3-20
3.5 Runtime Object Viewer (ROV) in CCStudioVA.X . .. ...ttt e i 3-27
3.6 Instrumentation Performance . .. ... .. 3-32
3.7 Instrumentation APIS . . ... 3-34

Vii



Contents

viii

3.8 Implicit DSP/BIOS Instrumentation. . . ...ttt 3-45
3.9 Instrumentation for Field Testing. . . .. ... ..o e 3-54
3.10 Real-TimeDataEXcChange . ........ ... e e 3-54
Thread Scheduling .. ... e e e 4-1

This chapter describes the types of threads a DSP/BIOS program can use, their behavior, and
their priorities during program execution.

4.1 Overview of Thread Scheduling .. ......... ... . e 4-2
4.2 Hardware INnterrupts ... ..o e 4-11
4.3 Software INterrUPtS . . ..o e 4-25
4.4 TaSKS. . o 4-39
4.5 The Idle LOOP . ..ottt e e e e 4-49
4.6 Power Management . .. ...... .. 4-51
4.7 SEMAPNOIES . . .o e e 4-60
4.8 MailbOXES . . . 4-66
4.9 Timers, Interrupts, and the System Clock. . ......... ... ... ... ... . ........ 4-72
4,10 Periodic Function Manager (PRD) and the System Clock ..................... 4-77
Memory and Low-level Functions . .......... . . . . .. 5-1

This chapter describes the low-level functions found in the DSP/BIOS real-time multitasking ker-
nel. These functions are embodied in the following software modules:

51 Memory Management . . . ... ... 5-2
5.2 SYSIEM SEIVICES . . o o e 5-12
5.3 QUEBUIS . . .o 5-15
Input/Output Methods . ... .. . 6-1
This chapter provides an overview of DSP/BIOS data transfer methods, and discusses pipes in
particular.

6.1 O OVEIVIEW . . o ot e e e e 6-2
6.2 Comparing Pipes and Streams . . . ... ..ot 6-3
6.3 Comparing Driver Models . . . .. ... 6-5
6.4 Data Pipe Manager (PIP Module) . . . ... 6-8
6.5 MesSsage QUEUES . . . ..ottt e e e e e 6-15
6.6 Host Channel Manager (HST Module) . ... e 6-27
6.7 I/O Performance ISSUES . . . . ... 6-28
Streaming /O and Device DriVers . ... ... e e e 7-1

This chapter describes issues relating to writing and using device drivers that use the DEV_Fxns
model, and gives several programming examples.

7.1 Overview of Streaming I/O and Device Drivers. . . ......... .. i, 7-2
7.2 Creating and Deleting Streams. . .. ... i e e 7-5
7.3 Stream I/O—Reading and Writing Streams . . .. ... ... 7-7
7.4 Stackable DeVICES. . . ... 7-16
7.5 Controlling Streams. . . . ...t e 7-22
7.6 Selecting Among Multiple Streams . . ... ... . e 7-23
7.7 Streaming Datato Multiple Clients . .. ........ ... e 7-25
7.8 Streaming Data Between Targetand Host . . .. ....... ... ... ... ... ... .. .... 7-27



7.9

7.10
7.11
7.12
7.13
7.14
7.15
7.16
7.17

Contents

Device Driver Template . .. ... .. e 7-28
Streaming DEV StrUCIUIES . . . . ..ot e e e e 7-30
Device Driver Initialization . . ........ ... e 7-33
OPENING DBVICES . ..ottt e e 7-34
Real-Time 11O . . . . 7-38
CloSING DBVICES . . o oo e e e e 7-41
Device Control . ... ..o 7-43
Device Ready . . ... 7-43
TYPES Of DBVICES . . v vttt e e 7-46

Contents ix



Figures

1-2
2-1
3-1
3-2
3-3
3-4
3-5
3-6
3-7
3-8
3-9
3-10
3-11

4-10
4-11
4-12
4-13
4-14
4-15
4-16

DSP/BIOS COMPONENTS ...ceiiiiiiieeieii ittt e e et et e e e e e e e e s e s s abbbbbeseeeaaaaaeasaaannnneeseens 1-4
Configuration TOOI MOAUIE TIEE......c.cciiiiiiieiieeie e e et e e e e s e s e e e e e e e e e e annnnnns 1-7
Files in @ DSP/BIOS APPlICALION.......ccuuuiiiiieiieeei e e e e e s e e e e e e e e snnnenaees 2-18
Execution Graph WINAOW .......oooiiiniiiiiiiiiie ettt et e e e 3-7
Kernel Object View Showing TSK Properties........cccuuueeiirreeeeiiiiiinieeieneee e e s sssesnveneeneeens 3-14
LGS (=TI (0] o= 11T PSS 3-17
LOG BUFfEI SEOUENCE ..eeeiiiiieiii ittt e e e e e e e e e e e anaereee s 3-36
Target/Host Variable ACCUMUIALION...........ccuiiiiiiiiiiee e 3-38
Current Value Deltas From ONE STS_ SEL.....ccccciiiiiiiiiiiiiiiiiieieee e e sssiniee e e e e e e e 3-40
Current Value Deltas from Base ValUe ...t 3-41
Monitoring Stack Pointers (C5000 platform).........ccccuvviiiiiiiiee e 3-48
Monitoring Stack Pointers (C6000 platform) .......cccvvvviiiiiiieeie e 3-48
Calculating Used Stack Depth ... 3-50
RTDX Data Flow between Host and Target.........cccvuveeeieiieeeiiiieciieieeeeeeee e e e e 3-55
TRrEAM PrIONLIES ..eeeiiiiiiiie ettt e e e st e e e e snbae e e e e enes 4-7
Pre@mplion SCENEAIIO .. ..ueiiiiiieee ettt e e e e e e et e e e e e e e e e e e e nnaebeeeeas 4-10
The Interrupt Sequence in Debug Halt State...........cccoovviiiiiiiiiii e, 4-15
The Interrupt Sequence in the RUN-tIME State .........ccooviiiiiiiiiiiiiee e 4-17
Software INTErrUPL MBNAGET ........cooi ittt e e e e e e e e e e e e e e e aanes 4-27
SWI Properties Dialog BOX .......uueeiiiieeeiiiiiiiiiiiiie it e e e e e e ss s seieteee e e e e e e e e e e ssnnsnrnrnaeneeaeeeennas 4-28
UsiNg SWI_INC t0 POSt @N SWi ..ottt e s seen e e e e e e e e s e nannnnnes 4-32
Using SWI_andn t0 POSt @N SW........ueiuiiiiiiiiiiiiiiee et 4-33
Using SWI_0r t0 POSt @n SWIL ...coooiiiee ettt eee e e e e e e e s nannnnes 4-34
Using SWI_dec t0 POSt @n SWI.........uuiiiiiiiieiii et e e e e e nnnannnee e 4-35
Execution Mode VariatiONsS .........oc.iuiiiiiiiiiae ettt 4-42
Trace from EXAMPIE 4-7 ...t e e e e e e e e s s s e e e e e e e e 4-48
Power EvVent NOLIfICAtION ........ooiiiiiiiiiiiiice et 4-56
Trace Results from EXampPle 4-11 .......ooooiiiiiiiiiiiiiee et a e 4-65
Trace Results from EXample 4-15 .....cooooiiiiiiiieiiieie e e e 4-70
Interactions Between Two Timing Methods .........ccvvviviiiiieei e 4-72



Figures

4-17  Trace Log Output from EXAmMPIE 4-16.....ccceveeeiiiieiiiiieiiieieeee e e e s e st eeer e e e e e e s enennnnnes 4-77
5-1 Allocating Memory Segments of Different Sizes ..., 5-8
5-2 V[T g o YA AN | ToTor= o] o I I - Vot PSSR 5-11
5-3 Trace Results from EXample 5-18 ........ccooiiiiiiiiiiiiiiiiece e aeee e 5-19
6-1 INPUL/OULPUL SIFEAM ...eeiiiiiiiiii ettt bttt e e e e e e e e et e e e e e e e e e e e e e annenbbeeeees 6-2
6-2 The TWO ENAS Of @ PIPE ...t a e e e e ae e e e e e e e s 6-8
6-3 Writers and Reader of a MeSsage QUEUE .........ccuvevviiiiieeee e e e e e e e e e e e s 6-15
6-4 Components of the MSGQ ArChit@CIUre ..........cooiiiiiiiiiiiiii e 6-16
6-5 MSGQ Function Calling SEQUENCE .......uuuiiiiiieeeee it e e e e e s s e e e e e e e e e anennnnee 6-17
6-6 Transports in a Multi-Processor EXample ............ueeiiiiiiiiiiiiieeee e 6-21
6-7 REMOLE TIaNSPOIT ...t e e e et et et e e et e e e abeb e b e bbb bb e e e e e e e e e eeeeas 6-22
6-8 Events on Sending Message to REMOte ProCESSOr .......uuvvivveeiiiiiiiiiiiieeieeee e 6-24
7-1 Device-Independent /O iN DSP/BIOS ........uuiiiiiiiiiai et 7-2
7-2 Device, Driver, and Stream RelationShip ...t 7-4
7-3 [ [0 1A (@ R o = ALY o] 1 <R 7-9
7-4 Output Trace for EXAmMPIE 7-5....oo et 7-12
7-5 RESUILS fOr EXAMPIE 7-6....eeeiiiiiieiieeitee ettt ettt e e e e e e e e e e ennees 7-14
7-6 The Flow of Empty and FUll Frames ..o 7-17
7-7 Sine Wave Output for EXamPpPle 7-9......ooeiiiie et 7-21
7-8 Flow of DEV_STANDARD Streaming Model ..........cccouiiiiiiiiiiiiieiieee s 7-38
7-9 Placing a Data BUffer to @ Strea@m............eeeeiiieeiiiiii e e e 7-39
7-10  Retrieving Buffers from a Stream ... 7-39
7-11  Stacking and Terminating DEVICES ........ccouiiiiiiiiiiiie ettt 7-46
7-12  Buffer Flow in @ Terminating DEVICE ..........coovcuiiiieiiiiiieee et ee e e e e e e s veeee e 7-47
7-13  In-Place Stacking DIIVEL ....cc..eeuiiiiiiiiiiiiee et e e e e e e eeeee s 7-47
7-14  Copying Stacking DIiVEr FIOW .........ueiiiiiiiiiiiiie et 7-48

Contents Xi



Tables

DSP/BIOS MOAUIES ...ttt e e e e e e e e bbb e e e e e e e e e e e e e e aannnnes 1-5
DSP/BIOS Standard Data TYPES: ....cccuurrerireireeieeeissiiitenieerreeeeeeesssssssssssssseereeseessessnnnsnnes 1-11
MemMOry SEQMENT NAIMES .......oeeiieieieieiii e e s e s e e e e e e te e e e e e eeeeaeeeereeneaen s e e e aaeeeeeaees 1-12
Standard MEemOry SEOMENTS ....ccoiiiiiiiiiiiititi ettt e e e e e e e e e e e s s ebe e eeaaeaaaaa s 1-13
Methods of Referencing C6000 Global ObjJects.........cccccvviveeeii i 2-13
Files Not Included iN rtSDIOS .........uviiiiiiie e 2-22
Stack Modes on the C5500 PIAtfOrm ............eeeiiiiiiiiiiii e 2-27
Examples of Code-size Increases Due to an Instrumented Kernel ..............ccoecvvvvnnee 3-33
TRC CONSTANTS: ... teeeiteeee et ettt e e e e e r et e e e e e e s e s e bbb e e e e et e e e e aeesaaanerenreeeeees 3-43
Variables that can be Monitored with HWI ... 3-51
STS Operations and Their RESUILS ........cc.vuviiiiiiiiie e e e 3-52
Comparison of Thread CharaCteriStiCS .......uuuuriiiiieeeiiiii i s e e 4-5
Thread Pre@mpPtion ...ttt e e e e e e e e e as 4-9
SWI Object FUNCtion DIffErENCES .....ccoov i 4-31
CPU Registers Saved During Software INterrupt..........ccevvvevveeeeeiiiiiiiiiieireeeeee e 4-36
Generic 1/0 to Internal Driver OPEratioNS ..........cciciiee it eea e 7-3

Contents

Xii



Examples

4-10
4-11
4-12
4-13
4-14
4-15
4-16
5-1
5-2
5-3
5-4
5-5

Xiii

Creating and Referencing Dynamic ODJECLS .........ooiiiiiiiiiiiiiiii e 2-17
Deleting a DYNamicC ODBJECT ......coi it e e e e e e e e 2-17
Sample Makefile for a DSP/BIOS Program ..........coooevicuviiieieireeeeeeesiissssieesneeresseeessennnns 2-21
Declaring Functions in an Extern C BIOCK ...........occuuiiiiiiiiiiie e, 2-29
Function Overloading Limitation ..........c.uueeiiiiieoiiiiiiiiiie e e 2-29
Wrapper Function for a Class Method...........ccccuuiiiiiiiiiic e 2-30
Gathering Information About Differences in Values ..o 3-40
Gathering Information About Differences from Base Value.............cccccvveviveeeeieeiinninns 3-41
B I S o | L= 1 Yo o PP 3-46
Interrupt Behavior for C28x During Real-Time Mode ............oocviiiiiiiiiiiieeee e 4-14
Code Regions That are Uninterruptible ... 4-18
Constructing a Minimal ISR on C6000 PIatform ........ccccuvveveiiieeeii i e 4-23
HWI Example on C55X PIatfOrm ..........oueiiiiiiiiiiiec et 4-23
HWI Example on C28X PlatfOrm ..........cuveiiioieiiiiiiiiiiie e ee e e e 4-24
Creating @ TaSK ODJECT.....uuuiiiiiiie e e e e e e e e e e e e e e e s e e e 4-45
TiMe-Slice SCheAUIING .....cooiii e 4-46
Creating and Deleting @ SEMAPRNOIE ........uviiiiiiiee e e e e e 4-60
Setting a Timeout With SEM_PENd ........ccuviiiiiiiiiee e e e e e e e 4-61
Signaling a Semaphore With SEM_POST ........uuiiiiiiiiiiiiii e 4-61
SEM Example Using Three WIter TASKS ......uvviieeeiiiiiciiiiiieieir e e e e s scesneeiee e e e e ae e e e 4-62
Creating @ MailDOX........ooiceiiee e e e e aaaea e 4-66
Reading a Message from @ MailbOoX ..........cccooiiiiiiiiiiiiiii e 4-66
Posting a Message t0 @ MailDOX.........uuuuiiiieeieeiiiiiiiiiieeir e e e e e 4-67
MBX Example With TWo Types Of TaskS ......ccoooviiiiiiiiiiieee e 4-68
Using the System CIock t0 Drive @ TaskK .......coooiiiiiiiiiiii e 4-76
Linker Command File (C6000 PIAtfOrM) ........cceeeiiiiiiiiiieiiiiee e e e e e e e 5-4
Linker Command File (C5000 and C28xX Platforms).........ccceeeeiiiiiiiiiiiiieneniee e 5-4
Using MEM_alloc for System-Level Storage ........cc.uuvuiiieiiiiiiiiiiiiieee e 5-5
Allocating an Array Of SITUCIUIES ....cuvveiiie e e e e anee e e 5-5
Using MEM_free t0 Fre@ MEIMOIY .....uuuiiiiiieeeeeie i i ettt et e e e e e e e e s st e e e e e e e e e e e snnnnnnnes 5-6



5-6
5-7
5-8
5-9
5-10
5-11
5-12
5-13
5-14
5-15
5-16
5-17
5-18
7-1
7-2
7-3
7-4
7-5
7-6

7-8

7-9

7-10
7-11
7-12
7-13
7-14
7-15
7-16
7-17
7-18
7-19
7-20
7-21
7-22
7-23
7-24
7-25
7-26

Examp
Freeing an Array Of ODJECES ...cvviiii i e e e e e e 5-6
Memory Allocation (C5000 and C28x PIlatforms).............ueeviiiiiiiiiiiiiiiiiiieceee s 5-9
Memory Allocation (C6000 PIatform) ........eeeveeeieiiiiiiiiiieeiee e e e e 5-10
Coding To Halt Program Execution with SYS_exit or SYS_abort..........ccccccvevveeeeeennn. 5-12
Using SYS_abort with Optional Data Values ...........ooccuuiiiiiiiiiiieiiiieeeece e 5-13
Using HandIErs in SYS_ EXit.....ccciiiiiiiiiiiiiiii et e e s s rr e e e e e e e e e e ennes 5-13
Using Multiple SYS_NUMHANDLERS ..o 5-13
DSP/BIOS Error HANAING ...coooiiiiiiiiiieee ettt 5-14
Using doError to Print Error INfOrmation ............cooooiciiiiiiiiieee e ee e 5-14
Managing QUE Elements USINg QUEUES. ........ceoiiiiiiiiiiiiiie et eeee e e e e e e eieees 5-15
Inserting iNto @ QUeUe AtOMICAIIY .........ueiiiiiiiii e 5-15
Using QUE Functions with Mutual Exclusion Elements..........cccccoovveiiviiiieeeeeee e 5-16
Using QUE t0 SeNd MESSATES .....coiiuiiiiiiiiiiiiaeaa ettt et e e e e e e e et ee e e e e e e e e e e s e e annnes 5-17
Creating a Stream With SIO_Create ...........uueiiiiiiiiiiiiiiee et 7-5
Freeing User-Held Stream BUFfers....... ... 7-6
Inputting and Outputting Data BUfers............oooiiii e 7-7
Implementing the Issue/Reclaim Streaming Model ...........ccccooiiiiiiiiiiiie e 7-8
BaSIC SIO FUNCHIONS ....cuviiiiiiiic ettt 7-10
Adding an Output Stream to EXample 7-5 ... 7-13
Using the Issue/Reclaim MOEI ............uuiiiiiiiiiiiai e 7-15
Opening a Pair of Virtual DEVICES .........ccccueeiiiiieiieee et e st a e e e e e 7-16
Data Exchange Through a Pipe DEVICE .......cccoiiiiiiiiiiiiiiiiie ittt 7-19
Using SIO_ctrl to Communicate wWith @ DEVICE ..........cccuiiiiiiiiiiiieei e 7-22
Changing SamPIE RALE.........uuuiiiiiiiiee et e e e e s e e eeaae s 7-22
Synchronizing With @ DEVICE .....ccoviiiiiiiiiie e 7-22
Indicating That a Stream iS REAAY .......coiiiiiiiiiiiiiieeee e 7-23
POIlING TWO SITEAIMS .. ..uiiiiiiiieiie e e s e e ettt e e e e e e s e s s st r e er e e e s e e s s snbr e rrereaeaeeeessannnnes 7-24
Using SIO_put to Send Data to Multiple ClIents .............oueiiiiiiiiiiiieeeee e 7-25
Using SIO_issue/SIO_reclaim to Send Data to Multiple Clients...........cccccceeeeiiiiiinnes 7-26
Required Statements in dxx.h Header File ...........coocciiiiiiiiiii e 7-29
Table Of DEeVICE FUNCHONS .......uuiiiiiiiiei ettt e e e e e e 7-29
The DEV_FXNS SHIUCKUI ... s s s e e e e e e e e e e e e e e e e aeee e 7-30
The DEV_Frame STIUCIUIE .......uuiiiiiiie et ee e e e e et er e e e e e e e s e e snnnnnraenaeeeeeas 7-30
The DEV_HaNAIE STIUCLUIE ......uiiiiiiei e e e e e e e e e e e e e e e e eeeeaaeeaees 7-31
INItialization DY DXX_INIt.....cooiiiiiiie e e e e e e e s s ee e 7-33
Opening a DeVvice With DXX_OPEN ...cccoii ittt e et e e e e e e e e s e aaer e er e e e e e e e 7-34
Opening an Input Terminating DEVICE ...........ueiiiiiiiiiiiiiiiiieie e 7-34
Arguments t0 DXX_OPEIN ...oiiiieieiei ettt e e e e e e e e e e e e e et e e e eee bbb bere b b s 7-34
The Parameters Of SIO_CrEate ......cuveeiiiiiic it e e e e e e e 7-35

Contents

les

Xiv



Examples

7-27
7-28
7-29
7-30
7-31
7-32
7-33

XV

The DXX_ODj StIUCLUIE ...t e e e e s e e e e e e e e e s s s raneeeeeees 7-35
Typical Features for a Terminating DEVICE .......cccouiiiiiiiiiiiiiiiiiiieee e 7-36
Template for Dxx_issue for a Typical Terminating DEVICE ........cccevveeeeiviiiciiviiiieeeeeeennn, 7-40
Template for Dxx_reclaim for a Typical Terminating DeviCe ........cccccceevvvecivvvvrieereennenn. 7-40
ClOSING @ DEBVICE ..ottt ettt e e e e e e e e e e s e bt et e aeeaaaaaeaeas 7-41
Making @ DEVICE REAAY ......cceeiiiiiiiiiiie e e et e e e e e e e s e e e e e e e e e e e e e nnrnnenees 7-43
] (@ IS 7= [T oY= 0 o (ool o = PSSR 7-44



XVi



Chapter 1

About DSP/BIOS

DSP/BIOS is a scalable real-time kernel. It is designed to be used by
applications that require real-time scheduling and synchronization, host-to-
target communication, or real-time instrumentation. DSP/BIOS provides
preemptive multi-threading, hardware abstraction, real-time analysis, and

configuration tools.

Topic Page
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1.2 DSP/BIOS COMPONENES . . .. vtt ittt i e e e e e e e 1-4
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DSP/BIOS Features and Benefits

1.1 DSP/BIOS Features and Benefits

1-2

DSP/BIOS is designed to minimize memory and CPU requirements on the
target. This design goal is accomplished in the following ways:

4

In

All DSP/BIOS objects can be configured statically and bound into an
executable program image. This reduces code size and optimizes
internal data structures.

Instrumentation data (such as logs and traces) are formatted on the host.

The APIs are modularized so that only those APIs that are used by the
program need to be bound into the executable program.

The library is optimized to require the smallest possible number of
instruction cycles, with a significant portion implemented in assembly
language.

Communication between the target and DSP/BIOS analysis tools is
performed within the background idle loop. This ensures that DSP/BIOS
analysis tools do not interfere with the program’s tasks. If the target CPU
is too busy to perform background tasks, the DSP/BIOS analysis tools
stop receiving information from the target until the CPU is available.

Error checking that would increase memory and CPU requirements has
been kept to a minimum. Instead, the API reference documentation
specifies constraints for calling API functions. It is the responsibility of the
application developer to meet these constraints.

addition, the DSP/BIOS API provides many options for program

development:

4

A program can dynamically create and delete objects that are used in
special situations. The same program can use both objects created
dynamically and objects created statically.

The threading model provides thread types for a variety of situations.
Hardware interrupts, software interrupts, tasks, idle functions, and
periodic functions are all supported. You can control the priorities and
blocking characteristics of threads through your choice of thread types.

Structures to support communication and synchronization between
threads are provided. These include semaphores, mailboxes, and
resource locks.

Two 1/0 models are supported for maximum flexibility and power. Pipes
are used for target/host communication and to support simple cases in
which one thread writes to the pipe and another reads from the pipe.
Streams are used for more complex I/O and to support device drivers.

Low-level system primitives are provided to make it easier to handle
errors, create common data structures, and manage memory usage.
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The DSP/BIOS API standardizes DSP programming for a number of TI
devices and provides easy-to-use powerful program development tools.
These tools reduce the time required to create DSP programs in the following
ways:

4

4

The Tconf configuration script generates code required to statically
declare objects used within the program.

The configuration detects errors earlier by validating properties before
the program is built.

Configuration scripts can be modified in a text editor to include branching,
looping, testing of command-line arguments and more.

Logging and statistics for DSP/BIOS objects are available at run-time
without additional programming. Additional instrumentation can be
programmed as needed.

The DSP/BIOS analysis tools allow real-time monitoring of program
behavior.

DSP/BIOS provides a standard APIl. This allows DSP algorithm
developers to provide code that can be more easily integrated with other
program functions.

DSP/BIOS is integrated within the Code Composer Studio v4 IDE,
requires no runtime license fees, and is fully supported by Texas
Instruments. DSP/BIOS is a key a component of Tl's eXpressDSPT'VI
real-time software technology.

1.1.1 What's New in DSP/BIOS 5.417?

4

DSP/BIOS is installed as part of either a Code Composer Studio v3 or v4
installation. Depending on the DSP/BIOS 5.41 installer used, DSP/BIOS
provides support for use in CCSv3 or CCSv4.

If you use the CCSv4 version of the DSP/BIOS installer, the following
features are available:

B DSP/BIOS and the Configuration Tool have been updated to be used
with the XDCtools version shipped with CCSv4.

B The examples have been restructured and simplified so that they can
be used to create CCSv4 projects.

B The Kernel/Object View (KOV) has been replaced with the Runtime
Object Viewer (ROV). New Real-Time Analysis tools have been
developed for use within CCSv4.
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1.2 DSP/BIOS Components

Figure 1-1.

1-4

Figure 1-1 shows DSP/BIOS components within the program generation and
debugging environment of Code Composer Studio:

DSP/BIOS Components

DSP/BIOS
Configuration

tef

(contg —

script) DSP/BIOS API

k generation
. tools
cfég-chc Code Composer project
cfg.cmd Compiler,

cfg.s62 assembler,
cfg.n62 Inker...

DSP/BIOS Analysis Tools executable DSP application program
Host emulation support

Host / Target

OO0OO0O000O0

Code Composer Studio

o
o
o
o
DSP o
o
o
o
o

O00O000000

OO0O0O0000

Code

DSP/BIOS
Code Composer debugger ITAG
RT

Target hardware

4 DSP/BIOS API. On the host PC, you write programs (in C, C++, or
assembly) that call DSP/BIOS API functions.

4 DSP/BIOS Configuration Tool. You create a configuration that defines
static objects to be used in your program. The configuration generates
files that you compile and link with the program.

4 DSP/BIOS Analysis Tools. These tools in Code Composer Studio let
you test the program on the target device while monitoring CPU load,
timing, logs, thread execution, and more. (Thread refers to any thread of
execution: hardware interrupt, software interrupt, task, or idle function.)

The sections that follow provide an overview of these DSP/BIOS components.
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1.2.1 DSP/BIOS Real-Time Kernel and API

Table 1-1.

DSP/BIOS is a scalable real-time kernel, designed for applications that require
real-time scheduling and synchronization, host-to-target communication, or
real-time instrumentation. DSP/BIOS provides preemptive multi-threading,
hardware abstraction, real-time analysis, and configuration tools.

The DSP/BIOS API is divided into modules. Depending on what modules are
configured and used by the application, the size of DSP/BIOS can range from
about 500 to 6500 words of code. All the operations within a module begin
with the letter codes shown Figure 1-1.

Application programs use DSP/BIOS by making calls to the APIL. All
DSP/BIOS modules provide C-callable interfaces. Most C-callable interfaces
can also be called from assembly language, provided that C calling
conventions are followed. Some of the C interfaces are actually C macros
and therefore, cannot be used when called from assembly language. Refer
to the TMS320 DSP/BIOS API Reference Guide for your platform for details.

DSP/BIOS Modules

Module Description

ATM Atomic functions written in assembly language
BUF Fixed-length buffer pool manager

C28, C55, C62, C64 Target-specific functions, platform dependent
CLK Clock manager

DEV Device driver interface

GBL Global setting manager

GIO General /0O manager

HOOK Hook function manager

HST Host channel manager

HWI Hardware interrupt manager

IDL Idle function manager

LCK Resource lock manager

LOG Event log manager

MBX Mailbox manager

MEM Memory segment manager

MSGQ Message queue manager

PIP Buffered pipe manager

POOL Allocator pool manager
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Module Description

PRD Periodic function manager
PWRM Power manager ('C55x and 'C6748 only)
QUE Atomic queue manager

RTDX Real-time data exchange settings
SEM Semaphore manager

SIO Stream |/O manager

STS Statistics object manager

SWI Software interrupt manager

SYS System services manager

TRC Trace manager

TSK Multitasking manager

1.2.2 DSP/BIOS Configuration Tool

1-6

A DSP/BIOS configuration allows you to optimize your application by creating
objects and setting their properties statically, rather than at run-time. This
both improves run-time performance and reduces the application footprint.

The source file for a configuration is a DSP/BIOS Tconf script, which has a
file extension of .tcf. There are two ways to access a DSP/BIOS

configuration:

[ Textually. You can edit the text
of the script using Code
Composer Studio or a separate

prog.module'Sw'). create] 'encoder'];
prog.module 5w ') create] 'decoder”'];

text editor. You code the configuration using JavaScript syntax. See the
DSP/BIOS Textual Configuration (Tconf) User’s Guide (SPRUO0Q7) for

details.

[ Graphically. You can view
configurations in read-only mode
with the DSP/BIOS Configuration
Tool, a graphical editor that

=118 SWI - Software Interrupt Manager
B decoder
B encoder

functions as a macro recorder for scripts. The interface is similar to that
of the Windows Explorer. The script is shown in the right pane as you

create it.

You can set a wide range of parameters used by DSP/BIOS at run time. The
objects you create are used by the application’s DSP/BIOS API calls. These
objects include software interrupts, tasks, 1/0 streams, and event logs.
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Figure 1-2. Configuration Tool Module Tree

g Global Settings

+|-4fh MEM - Memory Section Manager
|ﬁ|_ﬁ| BUF - Buffer Manager
il POOL - Allocator Manager
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é LCK - Resource Lock Manager
@ Inpuk/Qukput
+ @ Device Drivers
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+- B3 HST - Host Channel Manager
:'.%, PIP - Buffered Pipe Manager
:::_’: SIC - Skream Input and Qukpuk Manager
GI0 - General Inpuk/Oukput Manager
% M2 - Message Queue Manager

][~ F

When you save a configuration, Tconf generates files to be included in the
project. Using static configuration, DSP/BIOS objects can be pre-configured
and bound into an executable program image. Alternately, a DSP/BIOS
program can create and delete certain objects at run time.

In addition to minimizing the target memory footprint by eliminating run-time
code and optimizing internal data structures, creating static objects detects
errors earlier by validating object properties before program compilation.

See the DSP/BIOS online help and Section 2.3, Configuring DSP/BIOS
Applications Statically, page 2-11, for details.
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1.2.3 DSP/BIOS Analysis Tools

1-8

The DSP/BIOS analysis tools complement the Code Composer Studio
environment by enabling real-time program analysis of a DSP/BIOS
application. You can visually monitor a DSP application as it runs with
minimal impact on the application’s real-time performance.

If you are using CCSv3, use the DSP/BIOS menu to open the analysis tools.

If you are using CCSv4, the DSP/BIOS
analysis tools are found in the CCSv4 Tools

menu, as shown here. Trace Conkral !
See the DSP/BIOS online help and Chapter 3, Profile p o
Instrumentation for details about individual
analysis tools. RO

: " . . 3
Unlike traditional debugging, which is external i RTA
to the executing program, program analysis Graph "
requires the target program contain real-time I anal
instrumentation services. By using DSP/BIOS i [mage Analyzer

APIs and objects, developers automatically
instrument the target for capturing and uploading real-time information to the
host through the Code Composer Studio DSP/BIOS analysis tools.

Several broad real-time program analysis capabilities are provided:

[ Program tracing. Displaying events written to target logs, reflecting
dynamic control flow during program execution

[ Performance monitoring. Tracking summary statistics that reflect use
of target resources, such as processor load and timing

1 File streaming. Binding target-resident I/O objects to host files

When used in tandem with other debugging capabilities of Code Composer
Studio, the DSP/BIOS real-time analysis tools provide critical views into
target program behavior during program execution—where traditional
debugging techniques that stop the target offer little insight. Even after the
debugger halts the program, information already captured by the host with
the DSP/BIOS analysis tools can provide insight into the sequence of events
that led up to the current point of execution

Later in the software development cycle, when regular debugging techniques
become ineffective for attacking problems arising from time-dependent
interactions, the DSP/BIOS analysis tools have an expanded role as the
software counterpart of the hardware logic analyzer.
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1.3 Naming Conventions

Each DSP/BIOS module has a unique name that is used as a prefix for
operations (functions), header files, and objects for the module. This name is
comprised of 3 or more uppercase alphanumerics.

Throughout this manual, 64 represents the two-digit numeric appropriate to
your specific DSP platform. If your DSP platform is C6200 based, substitute
62 each time you see the designation 64. For example, DSP/BIOS assembly
language API header files for the C6000 platform will have a suffix of .h62.
For a C55x DSP platform, substitute 55 for each occurrence of 64. Also, each
reference to Code Composer Studio C5000 can be substituted with Code
Composer Studio C6000.

All identifiers beginning with upper-case letters followed by an underscore
(XXX_*) should be treated as reserved words.

1.3.1 Module Header Names

Each DSP/BIOS module has two header files containing declarations of all
constants, types, and functions made available through that module’s
interface.

@ xxx.h. DSP/BIOS API header files for C programs. Your C source files
should include std.h and the header files for any modules the C functions
use.

@ xxx.h##. DSP/BIOS API header files for assembly programs. Assembly
source files should include the appropriate xxx.h## header file for any
module the assembly source uses. For example, hwi.h62. This file
contains macro definitions specific to this device.

Your program must include the corresponding header for each module used
in a particular program source file. In addition, C source files must include
std.h before any module header files. (See Section 1.3.4, Data Type Names,
page 1-11, for more information.) The std.h file contains definitions for
standard types and constants. After including std.h, you can include the other
header files in any sequence. For example:

#include <std.h>
#include <tsk.h>
#include <sem.h>
#include <prd.h>
#include <swi.h>

DSP/BIOS includes a number of modules that are used internally. These
modules are undocumented and subject to change at any time. Header files
for these internal modules are distributed as part of DSP/BIOS and must be
present on your system when compiling and linking DSP/BIOS programs.

About DSP/BIOS 1-9
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1.3.2 Object Names

System objects included in the configuration by default typically have names
beginning with a 3- or 4-letter code for the module that defines or uses the
object. For example, the default configuration includes a LOG object called
LOG_system.

' Note:

Objects you create statically should use a common naming convention of
your choosing. You might want to use the module name as a suffix in object
names. For example, a TSK object that encodes data might be called
encoderTsk.

1.3.3 Operation Names

1-10

The format for a DSP/BIOS API operation name is MOD_action where MOD
is the letter code for the module that contains the operation, and action is the
action performed by the operation. For example, the SWI_post function is
defined by the SWI module; it posts a software interrupt.

This implementation of the DSP/BIOS API also includes several built-in
functions that are run by various built-in objects. Here are some examples:

@ CLK_F_isr. Run by an HWI object to provide the low-resolution CLK tick.

1 PRD_F _tick. Run by the PRD_clock CLK object to manage PRD_SWI
and system tick.

1 PRD_F_swi. Triggered by PRD _tick to run the PRD functions.

@ _KNL_run. Run by the lowest priority SWI object, KNL_swi, to run the
task scheduler if it is enabled. This is a C function called KNL_run. An
underscore is used as a prefix because the function is called from
assembly code.

1 _IDL_loop. Run by the lowest priority TSK object, TSK_idle, to run the
IDL functions.

1 IDL_F_busy. Run by the IDL_cpuLoad IDL object to compute the current
CPU load.

@ RTA_F _dispatch. Run by the RTA_dispatcher IDL object to gather real-
time analysis data.

d LNK_F_dataPump. Run by the LNK_dataPump IDL object to manage
the transfer of real-time analysis and HST channel data to the host.

d HWI_unused. Not actually a function name. This string is used in the
configuration to mark unused HWI objects.
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I Note:

Your program code should not call any built-in functions whose names
begin with MOD_F . These functions are intended to be called only as

function parameters specified in the configuration.
1 |

Symbol names beginning with MOD_ and MOD_F_ (where MOD is any letter
code for a DSP/BIOS module) are reserved for internal use.

1.3.4 Data Type Names

Table 1-2.

The DSP/BIOS API does not explicitly use the fundamental types of C such
as int or char. Instead, to ensure portability to other processors that support
the DSP/BIOS API, DSP/BIOS defines its own standard data types. In most
cases, the standard DSP/BIOS types are uppercase versions of the
corresponding C types.

The data types, shown in Table 1-2, are defined in the std.h header file.

DSP/BIOS Standard Data Types:

Type Description

Arg Type capable of holding both Ptr and Int arguments
Bool Boolean value

Char Character value

Fxn Pointer to a function

Int Signed integer value

Lgint Large signed integer value

LgUns Large unsigned integer value

Ptr Generic pointer value

String Zero-terminated (\0) sequence (array) of characters
Uns Unsigned integer value

Void Empty type

Additional data types are defined in std.h, but are not used by DSP/BIOS
APIs.

In addition, the standard constant NULL (0) is used by DSP/BIOS to signify
an empty pointer value. The constants TRUE (1) and FALSE (0) are used for
values of type Bool.

About DSP/BIOS 1-11
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Object structures used by the DSP/BIOS APl modules use a naming
convention of MOD_Obj, where MOD is the letter code for the object’s
module. If your program code uses any such objects created in the
configuration, it should make an extern declaration for the object. For
example:

extern LOG Obj trace;

Running the configuration script automatically generates a C header to file
that contains the appropriate declarations for all DSP/BIOS objects created
by the configuration (<program>.cfg.h). This file should be included by the
application’s source files to declare DSP/BIOS objects.

1.3.5 Memory Segment Names

The memory segment names used by DSP/BIOS are described in Table 1-3.
You can change the origin, size, and name of most default memory segments
in the configuration.

Table 1-3. Memory Segment Names

Memory Segment Names, C55x Platform

Segment Description
@ IDATA Primary block of data memory

DATAL Secondary block of data memory (not contiguous with

DATA)
PROG Program memory
VECT DSP Interrupt vector table memory segment

Memory Segment Names, C6000 EVM Platform

Q@ Segment Description

IPRAM Internal (on-device) program memory
IDRAM Internal (on-device) data memory
SBSRAM External SBSRAM on CEO

SDRAMO External SDRAM on CE2

SDRAM1 External SDRAM on CE3

Memory Segment Names, C6000 DSK Platform

Q'm Segment Description

SDRAM External SDRAM
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Memory Segment Names, C2800 DSK Platform

Segment Description

BOOTROM Boot code memory

FLASH Internal flash program memory

VECT Interrupt vector table when VMAP=0

VECT1 Interrupt vector table when VMAP=1

OTP One time programmable memory via flash registers
HOSARAM Internal program RAM

LOSARAM Internal data RAM

M1SARAM Internal user and task stack RAM

1.3.6 Standard Memory Sections

The configuration defines standard memory sections and their default
allocations as shown in Table 1-4. You can change these default allocations
using the MEM Manager. For more detail, see MEM Module in the TMS320
DSP/BIOS API Reference Guide for your platform.

Table 1-4. Standard Memory Segments

C55x Platform

Sections Segment
System stack Memory (.stack), DATA
System Stack Memory (.sysstack)

BIOS Kernel State Memory (.sysdata) DATA
BIOS Objects, Configuration Memory (.*obj) DATA
BIOS Program Memory (.bios) PROG

BIOS Startup Code Memory (.sysinit, .gblinit, .trcinit) PROG

Application Argument Memory (.args) DATA
Application Program Memory (.text) PROG
BIOS Heap Memory DATA
Secondary BIOS Heap Memory DATA1
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C6000 Platform

Qh@ Sections Segment

System stack memory (.stack) IDRAM
Application constants memory (.const) IDRAM
Program memory (.text) IPRAM
Data memory (.data) IDRAM
Startup code memory (.sysinit) IPRAM
C initialization records memory (.cinit) IDRAM
Uninitialized variables memory (.bss) IDRAM

C2800 Platform

Sections Segment
System stack memory (.stack) M1SARAM
Program memory (.text) IPROG
Data memory (.data) IDATA
Applications constants memory (.const) IDATA
Startup code memory (.sysinit) IPROG

C initialization records memory (.cinit) IDATA
Uninitialized variables memory (.bss) IDATA

1.4 For More Information
For more information about the components of DSP/BIOS and the modules

in the DSP/BIOS API, see the DSP/BIOS section of the online help system,
or the TMS320 DSP/BIOS API Reference Guide for your platform.
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Chapter 2

Program Generation

This chapter describes the process of generating programs with DSP/BIOS.
It also explains which files are generated by DSP/BIOS components and how
they are used.
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2.1 Creating and Building a CCSv4 Project for DSP/BIOS Applications
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To create a new CCSv4 project that uses DSP/BIOS, follow these steps. You
can also watch these steps being performed by going to the wiki page at
http://wiki.davincidsp.com/index.php/Quick_Tips, scrolling to the DSP/BIOS
section, and then following the link to watch the first demo.

1) Create a CCS project as follows:

2)

a)

b)

Open CCSv4 and choose File > New > CCS Project from the menu
bar.

In the New CCS Project dialog, type a Project Name. For example,
to begin creating a project using the "hello world" example code
provided with DSP/BIOS, you can type "hellobios5". The default
project location automatically reflects the project name. Then, click
Next.

Select your platform type in the Project Type field. For example, you
might select "C6000". Then, click Next.

Click Next in the "Additional Project Settings" page.

In the "CCS Project Settings" page, select the Device Variant for
your desired platform. For example, you might select "Generic C64x+
Device". Depending on your device, you might also need to adjust
the Device Endianness and Runtime Support Library settings.

In the Target content area, select the Use DSP/BIOS v5.xx option.
The version of DSP/BIOS installed with CCSv4 should already be
selected. Then, click Finish. This adds your project to the C/C++
Projects list in CCS.

Target conkent
O Mone

(%) Use DSPIBIOS vwE.x0x | 5,40 w

() Enable RTSC suppart {required for using DSPIBIOS w6, xx)

Create a DSP/BIOS Configuration for your project as follows:

a)
b)

Choose File > New > DSP/BIOS v5.xx Configuration.

Change the Filename to match your project name (if it doesn’t
already match). For example, if your project name is "hellobios5",
change the configuration filename to hellobios5.tcf. Then, click Next.

Select a platform for the configuration to use from the list of platforms.
These platforms are provided by XDCtools. Then, click Next.



Creating and Building a CCSv4 Project for DSP/BIOS Applications

d) Inthe list of DSP/BIOS Features, you can disable features if you are
sure you won't want to use them. Disabling features reduces the
application’s code size, but limits functionality. Then, click Finish.

DEP[EIOS Features
Real-Time Analysis
RTD

T3k Manager

I Real-Time Analysis. Disabling this feature prevents the
gathering of LOG, STS, and other instrumentation data from the
target. See Section 3.1.

I RTDX. Real-Time Data eXchange provides for target-host
communication. If you disable RTDX, you will not be able to view
real-time analysis (RTA) data. The ROV tool provides stop-mode
access to data, and is supported even if RTDX is disabled. See
Section 3.10.

I TSK Manager. Tasks are threads that allow yielding and can use
thread synchronization objects such as semaphores. Most
applications use tasks, but some may only use hardware and
software interrupts. See Section 4.4.

e) After you click Finish, the DSP/BIOS Configuration Tool opens. In
the Configuration Tool window, perform any tasks required by your
application. See Section 2.1.1 for details on performing these tasks:

For example, in the hello example, you would expand the
Instrumentation category and create a LOG object called "trace".

ry Configuration Tool - [C:\Documents and Settings\Compaqg_Administratoriby
File Edit ew Object Help

D[] &[%[@] 2%

Eztimated Data Size: 2032 Est. Min. Stack Size [ME | race properties

+ @ System Property Value
- EE Instrurmentation cornment <add comments he. ..
- [ LOG - Event Log Manager bufseg IRAM
B LOG_system buflen {words) 6_4
B LTgttytpe clr.cl;zl::ar
- [E] 55 - Sratistics Object Manager F;; ;;DE E::,DXJ O, O
+- 28 Scheduling
+ Synchronization
+ Inpuk/Cukput
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f)

Save the configuration by choosing File > Save or clicking the Save
icon. You can close the DSP/BIOS Configuration Tool at this point,
but can always return later to make further changes.

3) Add a source file to your project in one of the following ways:

You can create a new file by choosing File > New > Source File.

You can add an existing file to your project by choosing Project >
Add Files to Active Project (copies the file to your workspace) or
Project > Link Files to Active Project (does not copy the file; uses
the original location).

For example, you might choose Project > Add Files to Active
Project and browse to the C:\Program Files\Texas
Instruments\bios_5_40\packages\ti\bios\examples directory to add
the hello.c file. See Section 2.1.2 for a brief overview of how hello.c
uses DSP/BIOS.

Note that the provided examples expect specific filenames for the
DSP/BIOS Configuration File. For example, hello.c #includes
hellocfg.h, which would be generated from a configuration file called
hello.tcf. If your configuration file has a different name, you should
modify the #include statement. For example, if your configuration file
is hellobios5.tcf, modify the hello.c file to #include the hellobios5cfg.h
file.

4) Create a target configuration for the CCS project to use when building as
follows:

5)

a)
b)

d)

Choose File > New > Target Configuration File.

Type a filename for the target configuration, which will be stored as
part of the CCS project. For example, you might type
TCl6482sim.ccxml if that reflects the target you want to use. Then,
click Finish.

In the Connection field for your target configuration, choose the type
of connection you have to the target. Then type part of the target
name in the Device filter field. For example, you might choose the "TlI
Simulator" connection and filter by "64xp" to find a C64x+ simulator.

Choose File > Save or click the Save icon to save your target
configuration.

Build your project as follows:

a)
b)

Choose Project > Build Active Project.

Examine the log in the Console tab to diagnose any errors. Notice
that when you build, the DSP/BIOS Configuration .tcf file is
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processed to generate a number of files that are listed in the Debug
node of the project list.

6) Run the application as follows:

a) Choose Target > Debug Active Project or click the Debug icon. The
application runs and halts before the first statement in main().

b) Set breakpoints by double-clicking in the margin next to lines where
you want to stop. For example, in hello.c you might set a breakpoint
on the return; line.

¢) Choose Tools > ROV to open the Runtime Object Viewer, which
allows you to view the state of objects created with RTSC packages,
such as DSP/BIOS.

d) Expand the hierarchy in the ROV tool so you can select the "trace”
LOG.

= &4 hellobioss. oot # || Logs |
B xde [= xdc.rov.bioss, LG
= B o LOia_system
= 3 bioss krace
& LoS =
@ MEx
& MEM "

e) Choose Target > Run or click the Run icon to run to the breakpoint.

f)  The information for the "trace" LOG should now show the message
sent by LOG_ printf.

= gﬁ hellobioss . out A || Logs
= [E xdc = wdc.rov. biosg,LoG A SEQNUM Message
B € rov B LG _sysbem =k 1] hella warld!
= 8 bioss [= trace =
® L0G v 0 v

g) See Section 3.5 for more information about using the ROV tool. See
Section 3.4 for information about using Real-Time Analysis tools for
debugging.
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2.1.1 Using the DSP/BIOS Configuration Tool

The DSP/BIOS Configuration Tool lets you configure the modules that make
up the DSP/BIOS kernel. The modules are shown in the left pane of the tool.

g Global Setkings

+|--4ifh MEM - Memory Section Manager
|ﬁ|_ﬁ| BUF - Buffer Manager
|ﬁ|_ﬁ| POCL - Allocator Manager
SY3 - Syskem Setkings
@: HOOK, - Madule Hook Manager
EE Instrumentation
+- [ LOG - Event Log Manager
+ 5T5 - Skatistics Object Manager
- QB Scheduling
+- {8 CLK - Clock Manager
@ PRD - Perindic Function Manager
'"L HWT - Hardware Interrupt Service Rouking Manager
B 5wl - Software Interrupt Manager
@ TSE - Task Manager
[:] I0L - Idle Function Manager
@n Synchronization
‘}Q‘ SEM - Semaphare Manager
% MEY - Mailbox Manager
+ "'_T,l QUE - Atamic Queue Manager
é LCK - Resource Lock Manager
@. Inpuk/Cukpuk
+ €3 Device Drivers
@ RTD¥ - Real-Time Data Exchange Settings
+-B3 HST - Host Channel Manager
zk, PIP - BuFfered Pipe Managet
:;:_': SIC - Skrearm Input and Oukpuk Manager
GI0 - General Inpuk/Oukpuk Manager
% MSE0) - Message Queus Manager

F]-- [

Modules have a manager, for which you can set properties. In addition, most
modules let you create object instances, for which you can set properties.

In the DSP/BIOS Configuration Tool, you can perform the following actions:
[ Create and name objects. See Section 2.1.1.1.

[ Setglobal properties for the application, module manager properties, and
object properties. See Section 2.1.1.2.

d Set priorities for software interrupts and tasks. See Section 2.1.1.3.

[ Add comments and blank lines to the script. See Section 2.1.1.4.
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2.1.1.1 Creating Objects in the Configuration Tool

To create a new object with the Configuration Tool, follow these steps:

1)

2)
3)

Select the manager for the object type you want to create. For example,
if you want to create an SWI object, select the SWI manager.

Choose Object > Insert or right-click and choose Insert.

Type a name for the new object in the Insert Object dialog.

2.1.1.2 Setting Properties in the Configuration Tool

To set properties for a module or object, follow these steps:

1)

2)

3)

Select the manager or object whose properties you want to set and
choose Object > Properties or right-click and choose Properties.
Global properties for the configuration are in the System category.

In the Properties dialog, change the property settings as desired. Items
with a large number of properties have the tabs that contain various
categories of properties. For context-sensitive help about properties,
click Help in any Properties dialog.

When you have finished setting properties, click OK.

2.1.1.3 Setting Priorities in the Configuration Tool

You can set priority levels for SWI or TSK object. Likewise, you can set the
execution order of CLK, PRD, IDL, and HOOK objects. To set such priorities
or execution orders, follow these steps:

1)

2)

3)

In the Configuration Tool, highlight the manager whose priorities or order
you want to set.

Notice that the objects in the middle pane of the window are listed by
priority or execution order. (If you do not see the priority list in the right
half of the window, right-click on the manager and choose Ordered
collection view from the menu.)

Drag objects to the priority levels or execution order you want to use.

2.1.1.4 Modifying the Script in the Configuration Tool

The right pane of the Configuration Tool shows the current .tcf script. As you
make changes to objects and properties, the statements that create that
configuration are shown in the right pane. You can modify the script slightly
by clicking on a location in the script and choosing Insert Comment or Insert
Blank Line. If you want to make more substantial changes to the text of the
script, you can use CCS to open the .tcf file with a Text Editor.
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2.1.2 How hello.c Uses DSP/BIOS

2-8

The hello.c program uses DSP/BIOS’s LOG module to send a message to
the host.

The first few lines include the header files for DSP/BIOS modules used in this
file. In DSP/BIOS programs, always include the std.h file first, then include the
module header files. This example uses the LOG module, so that header file
is also included.

#include <std.h>
#include <log.h>

The program must also include the header file that will be generated from the
.tcf configuration file. This file has the filename <tcf_file>cfg.h. For example,
if the .tcf file for a project is hello.tcf, the #include statement would be as
follows:

#include "hellocfg.h"

The main() function simply prints a message to a log using the LOG_ printf
API. This API is very efficient. To reduce execution time, LOG_printf just
passes raw data to the host PC; formatting is done on the PC.

/* ======== main ======== %/
Void main ()

{

LOG printf (&trace, "hello world!");

After the main() function is complete, it returns. In more complicated
applications, the return statement has the effect of turning control over to
DSP/BIOS scheduling to run hardware interrupts (HWI), software interrupts
(SWI), tasks (TSK), and idle functions (IDL) as needed.

/* fall into DSP/BIOS idle loop */
return;
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2.1.3 The Development Cycle

DSP/BIOS supports iterative program development cycles. You can create
the basic framework for an application and test it with a simulated processing
load before the DSP algorithms are in place. You can easily change the
priorities and types of program threads that perform various functions.

A sample DSP/BIOS development cycle includes the following steps, though
iteration can occur for any step or group of steps:

1)

2)

3)

4)

5)

6)

Configure static objects for your program to use. This can be done using
the DSP/BIOS Configuration Tool or the Tconf scripting language.

Write a framework for your program. You can use C, C++, assembly, or
a combination of the languages.

Add files to your project and compile and link the program using Code
Composer Studio.

Test program behavior using a simulator or initial hardware and the
DSP/BIOS analysis tools. You can monitor logs and traces, statistics
objects, timing, software interrupts, and more.

Repeat steps 1-4 until the program runs correctly. You can add
functionality and make changes to the basic program structure.

When production hardware is ready, modify the configuration to support
the production board and test your program on the board.
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2.2 Converting CCSv3.3 Projects to CCSv4 Projects

To import a CCSv3.3 project into CCSv4, choose Project > Import Legacy
CCSv3.3 Project in CCSv4. Follow the instructions in the import wizard. For
more information about converting CCSv3.3 projects to CCSv4 projects, go
to http://tiexpressdsp.com/wiki/index.php?titte=CCSv4 and follow the link
near the bottom of the page to the "Migrating to CCSv4" topic.

If you are importing a project that uses DSP/BIOS, the wizard asks you to
select the version of DSP/BIOS you want the imported project to use. It is
recommended that you select a DSP/BIOS 5.4x version. This version of
DSP/BIOS is compatible with previous 5.x versions.

If you select a DSP/BIOS 6.x version, you will need to make changes to your
source code and configuration.

If you select a DSP/BIOS version prior to 5.40, you will not have access to the
ROV tool and Real-time Analysis debugging features.

2.2.1 Notes for Adding DSP/BIOS to Existing Projects
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If your project previously had its own linker command file, you may want to
remove the old linker command file from the project or use both linker
command files. In a DSP/BIOS application, programcfg.cmd is your project's
linker command file. This file already includes directives for the linker to use
the appropriate libraries (e.g., bios.a62, rtdx.lib, rts64plus.lib), so you do not
need to add any of these library files to your project.

For most DSP/BIOS applications the generated linker command file,
programcfg.cmd, suffices to describe all memory segments and allocations.
All DSP/BIOS memory segments and objects are handled by this linker
command file. In addition, most commonly used sections (such as .text, .bss,
.data, etc.) are already included in programcfg.cmd. Their locations (and
sizes, when appropriate) can be controlled from the MEM Manager in the
configuration. In some cases an application can require an additional linker
command file (app.cmd) to describe application-specific sections that are not
described in the linker command file generated by the configuration.

If your project includes the vectors.asm source file, you should remove that
file from the project. Hardware interrupt vectors are automatically defined in
the DSP/BIOS configuration.

Code Composer Studio software automatically scans all dependencies in
your project files, adding the necessary DSP/BIOS and RTDX header files for
your configuration to your project's include folder. So, you don't need to
explicitly add DSP/BIOS header files to the project.



Configuring DSP/BIOS Applications Statically

2.3 Configuring DSP/BIOS Applications Statically

As Section 1.2.2, DSP/BIOS Configuration Tool, page 1-6 describes,
DSP/BIOS configurations allow you create objects and set their properties
statically, rather than at run-time. You can choose to create a configuration
graphically, textually, or using a combination of these methods.

The DSP/BIOS Textual Configuration (Tconf) User’'s Guide (SPRUO0Q07)
contains details on the syntax used in configuration scripts.

2.3.1 When to Use Graphical Configuration

Use the DSP/BIOS Configuration Tool for the following advantages:

4

4

If you want a tree-view interface that makes it easy to see the available
properties for each module and object.

If you want to be prevented from making errors by the interface, which
provides drop-down lists of valid values and disables invalid commands
and fields.

You can use a text editor to modify a configuration script and then reload the
script into the DSP/BIOS Configuration Tool for further graphical editing.
There are certain restrictions on graphical editing after you have edited a
script or started a new configuration session.

2.3.2 When to Use a Text Editor

Use a text editor to modify a script if you want the following advantages:

]
M

If you want a script to use branching, looping, and other constructs.

If you want to create a number of similar objects. You can do this with cut-
and-paste or by looping over a create method.

If you want to modularize settings you use in a set of applications. For
example, if your applications all use similar instrumentation objects, all
applications can include a single file that creates those objects.

If you want the configuration to use the same symbol definitions as
program source files. You can do this by defining variables for use in
scripts and generating a C header file from the script to be included by
the program source code.

If you want to create similar configurations, you can pass command-line
arguments to a script. For example, you might optimize a program by
varying the number of tasks created and testing resulting applications.
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@ If you want to use standard code editing tools. For example, to merge
changes from multiple developers, compare application configurations,
and cut and paste between program configurations.

@ If you want to use UNIX.

DSP/BIOS configurations should not be confused with other items used for
configuration within Code Composer Studio.

2.3.3 Referencing Statically Created DSP/BIOS Objects

Statically-created objects that you reference in a program need to be
declared as extern variables outside all function bodies. For example, the
following declarations make the PIP_Obj object visible in all functions that
follow its definition in the program.

extern far PIP Obj inputObj; /* C6000 devices */
or
extern PIP_Obj inputObj; /* C5000 and C2800 devices */

The configuration generates a file that contains these declarations. The file
has a name of the form *cfg.h, where * is the name of your program. This file
can be #included in C files that reference DSP/BIOS objects.

2.3.3.1 Small and Large Model Issues for C6000
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B

Although DSP/BIOS itself is compiled using the small model, you can compile
DSP/BIOS applications using either the C6000 compiler’s small model or any
variation of the large model. (See the TMS320C6000 Optimizing Compiler
User’s Guide .) In fact, you can mix compilation models within the application
code provided all global data that is accessed by using a displacement
relative to B14 is placed no more than 32K bytes away from the beginning of
the .bss section.

DSP/BIOS uses the .bss section to store global data. However, objects
configured statically are not placed in the .bss section. This maximizes your
flexibility in the placement of application data. For example, the frequently
accessed .bss can be placed in on-device memory while larger, less
frequently accessed objects can be stored in external memory.

The small model makes assumptions about the placement of global data in
order to reduce the number of instruction cycles. If you are using the small
model (the default compilation mode) to optimize global data access, your
code can be modified to make sure that it references statically-created
objects correctly.
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There are four methods for dealing with this issue. These methods are
described in the sections following and have the pros and cons as shown in
Table 2-1.

Table 2-1. Methods of Referencing C6000 Global Objects

Declare Use global  Objects Compile

objects object adjacent with large
Method with far pointers to .bss model
Code works independent of compilation model Yes Yes Yes Yes
Code works independent of object placement Yes Yes No Yes
C code is portable to other compilers No Yes Yes Yes
Statically-created object size not limited to 32K bytes  Yes Yes No Yes
Minimizes size of .bss Yes Yes No Yes

No No Yes No

Minimizes instruction cycles

Minimizes storage per object

(3 cycles) (2-6 cycles) (1 cycle) (3 cycles)

No No Yes No
(12 bytes) (12 bytes) (4 bytes) (12 bytes)

Easy to program; easy to debug Somewhat Error prone  Somewhat Yes

2.3.3.2 Referencing Static DSP/BIOS Objects in the Small Model

B

In the small model, all compiled code accesses global data relative to a data
page pointer register. The register B14 is treated as a read-only register by
the compiler and is initialized with the starting address of the .bss section
during program startup. Global data is assumed to be at a constant offset
from the beginning of the .bss section and this section is assumed to be at
most 32K bytes in length. Global data, therefore, can be accessed with a
single instruction like the following:

LDW *+DP( x), A0 ; load x into A0 (DP = B14)

Since objects created statically are not placed in the .bss section, you must
ensure that application code compiled with the small model references them
correctly. There are three ways to do this:
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([ Declare static objects with the far keyword. The DSP/BIOS compiler

supports this common extension to the C language. The far keyword in a
data declaration indicates that the data is not in the .bss section.

For example, to reference a PIP object called inputObj that was created
statically, declare the object as follows:

extern far PIP Obj inputObj;
if (PIP_getReaderNumFrames (&inputObj)) {

}

Create and initialize a global object pointer. You can create a global
variable that is initialized to the address of the object you want to
reference. All references to the object must be made using this pointer,
to avoid the need for the far keyword. For example:

extern PIP Obj inputObj;

/* input MUST be a global variable */

PIP Obj *input = &inputObj;

if (PIP_getReaderNumFrames (input)) {

}

Declaring and initializing the global pointer consumes an additional word
of data (to hold the 32-bit address of the object).

Also, if the pointer is a static or automatic variable this technique fails.
The following code does not operate as expected when compiled using
the small model:

extern PIP Obj inputObj;
static PIP Obj *input = &inputObj; /* ERROR!!!! */
if (PIP_getReaderNumFrames (input)) {

}

Place all objects adjacent to .bss. If all objects are placed at the end of
the .bss section, and the combined length of the objects and the .bss data
is less than 32K bytes, you can reference these objects as if they were
allocated within the .bss section:

extern PIP Obj inputObj;

if (PIP_getReaderNumFrames (&inputObj)) {

}

You can guarantee this placement of objects by using the configuration
as follows:
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a) Declare a new memory segment by creating a MEM object and
setting its properties (i.e., the base and length); or use one of the
preexisting data memory MEM obijects.

b) Place all objects that are referenced by small model code in this
memory segment.

c) Place Uninitialized Variables Memory (.bss) in this same segment.

2.3.3.3 Referencing Static DSP/BIOS Objects in the Large Model

B

In the large model, all compiled code accesses data by first loading the entire
32-bit address into an address register and then using the indirect addressing
capabilities of the LDW instruction to load the data. For example:

MVKL _x, A0 ; move low 16-bits of _x’s address into A0
MVKH _x, AO ; move high 16-bits of x’s address into A0
LDW *A0, A0 ; load x into A0

Application code compiled with any of the large model variants is not affected
by the location of static objects. If all code that directly references statically-
created objects is compiled with any large model option, code can reference
the objects as ordinary data:

extern PIP Obj inputObj;
if (PIP_getReaderNumFrames (&inputObj)) {

}

The -ml0 large model option is identical to small model except that all
aggregate data is assumed to be far. This option causes all static objects to
be assumed to be far objects but allows scalar types (such as int, char, long)
to be accessed as near data. As a result, the performance degradation for
many applications is quite modest.
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2.4 Creating DSP/BIOS Objects Dynamically
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For typical DSP applications, most objects should be created statically
because they are used throughout program execution. A number of default
objects are automatically defined in the configuration template. Creating
objects statically provides the following benefits:

4

Reduced code size. For a typical module, the XXX create() and
XXX _delete() functions contain 50% of the code required to implement
the module. If you avoid using any calls to TSK create() and
TSK_delete(), the underlying code for these functions is not included in
the application program. The same is true for other modules. By creating
objects statically, you can dramatically reduce the size of your application
program.

Improved run-time performance. In addition to saving code space,
avoiding dynamic creation of objects reduces the time your program
spends performing system setup.

Creating objects statically has the following limitations:

4

4

Static objects are created whether or not they are needed. You may want
to create objects dynamically if they will be used only as a result of
infrequent run-time events.

You cannot delete static objects at run-time using the XXX _delete
functions.

You can create many, but not all, DSP/BIOS objects by calling the function
XXX_create where XXX names a specific module. Some objects can only be
created statically. Each XXX_create function allocates memory for storing the
object’s internal state information, and returns a handle used to reference the
newly-created object when calling other functions provided by the XXX
module.
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Most XXX _create functions accept as their last parameter a pointer to a
structure of type XXX_Attrs which is used to assign attributes to the newly-
created object. By convention, the object is assigned a set of default values
if this parameter is NULL. These default values are contained in the constant
structure XXX_ATTRS listed in the header files, enabling you to first initialize
a variable of type XXX_Attrs and then selectively update its fields with
application-dependent attribute values before calling XXX_create. Sample
code that creates a dynamic object using the TSK_create is shown in

Example 2-1.
Example 2-1.

Creating and Referencing Dynamic Objects

#include <tsk.h>
TSK_Attrs

TSK_Handle task;

attrs.priority =

attrs;

attrs = TSK ATTRS;
attrs.name = "reader";

TSK _MINPRI;

task = TSK create((Fxn)foo,

&attrs) ;

The XXX _create function passes back a handle that is an address to the
task’s object. This handle is can then be passed as an argument when
referencing, for example, deleting the object, as shown in Example 2-2.
Objects created with XXX _create are deleted by calling the function
XXX _delete. This frees the object’s internal memory back to the system for

later use.

Use the global constant XXX_ATTRS to copy the default values, update its
fields, and pass as the argument to the XXX_create function.

Example 2-2. Deleting a Dynamic Object

TSK delete (task)

7

Dynamically-created DSP/BIOS objects allow for a program to adapt at

runtime.

Program Generation

2-17



Files Used to Create DSP/BIOS Programs

2.5 Files Used to Create DSP/BIOS Programs

Figure 2-1 shows files used to create DSP/BIOS applications. Files you write
are shown with a white background; generated files have a gray background.
The word program represents the name of your project or program. The
number 62 is replaced by 28, 55, or 64 as appropriate for your platform.

Figure 2-1. Files in a DSP/BIOS Application

L |*asm,*c, *h, *cmd program.tcf
program.c and/or *.cpp (optional)
generate
|
include v ¥
programcfg.h62 programcfg_c.c >
module.h 1 module.h62 programcfg.cmd
programcfg.s62 programcfg.h
) assemble — compile —
— compileor
‘ assemble ’7 i i
program.obj * obj programcfg.obj programcfg_c..obj
program.out

Program Files

@ program.c. Program source file containing the main function. You can
also have additional .c source files and program .h files. For user
functions, see Section 2.10, User Functions Called by DSP/BIOS.

[ program.tcf. The Tconf script that generates the configuration files when
run. This is the source file for the configuration. This is the file you add to
a Code Composer Studio project to make the configuration part of the
application.

[ *.asm. Optional assembly source file(s). One of these files can contain
an assembly language function called _main as an alternative to using a
C or C++ function called main.

@ module.h. DSP/BIOS API header files for C or C++ programs. Your
source files should include std.h and the header files for any modules the
program uses.
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module.h62. DSP/BIOS APl header files for assembly programs.
Assembly source files should include the *.h64 header file for any module
the assembly source uses.

program.obj. Object file(s) compiled or assembled from your source file(s)
*.0bj. Object files for optional assembly source file(s)

*.cmd. Optional linker command file(s) that contains additional sections
for your program not defined by the DSP/BIOS configuration.

program.out. An executable program for the target (fully compiled,
assembled, and linked). You can load and run this program with Code
Composer Studio commands.

Static Configuration Files

When you build a project that contains a *.tcf file in CCS, the following files
are automatically created and added to the Debug folder of the project list
(where "program" is the configuration file name and 62 is replaced by 28, 55,
or 64 as appropriate for your platform):

4

programcfg.cmd. Linker command file for DSP/BIOS objects. This file
defines DSP/BIOS-specific link options and object names, and generic
data sections for DSP programs (such as .text, .bss, .data, etc.).

programcfg.h. Includes DSP/BIOS module header files and declares
external variables for objects created in the configuration.

programcfg_c.c. Defines DSP/BIOS related objects. (No longer defines
CSL objects.)

programcfg.s62. Assembly language source file for DSP/BIOS settings.

programcfg.h62. Assembly language header file included by
programcfg.s62.

program.cdb. Stores configuration settings for use by run-time analysis
tools. In previous versions, this was the configuration source file. It is now
generated by running the *.tcf file. This file is used by the DSP/BIOS
analysis tools.

programcfg.obj. Object file created from the source file generated by
the configuration.
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2.6 Using Makefiles to Build Applications
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You can build your DSP/BIOS executables using a Code Composer Studio
project or using your own makefile. The Code Composer Studio software
includes gmake.exe, the GNU make utility.

For details specific to your version of DSP/BIOS, see the SetupGuide.html
and release_notes.html files in your DSP/BIOS installation.

As an alternative to building your program as a Code Composer Studio
project, you can use a makefile.

In the following example, the C source code file is volume.c, additional
assembly source is in load.asm, and the configuration file is volume.cdb. This
makefile is for use with gmake, which is included with the Code Composer
Studio software.

A typical makefile for compiling and linking a DSP/BIOS program is shown in
Example 2-3.

Unlike the Code Composer Studio project, makefiles allow for multiple linker
command files. If the application requires additional linker command files you
can easily add them to the CMDS variable in the example makefile shown in
Example 2-3. However, they must always appear after the programcfg.cmd
linker command file generated by the Configuration Tool.
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Example 2-3. Sample Makefile for a DSP/BIOS Program

# Makefile for creation of program named by the PROG variable
# The following naming conventions are used by this makefile:

<progs>.asm - C55 assembly language source file
<progs>.obj - C55 object file (compiled/assembled source)
<progs.out - C55 executable (fully linked program)
<prog>cfg.s55 - configuration assembly source file

generated by Configuration Tool
<prog>cfg.h55 - configuration assembly header file

generated by Configuration Tool
<prog>cfg.cmd - configuration linker command file

generated by Configuration Tool

HH o HHH

include $(TI_DIR)/c5500/bios/include/c55rules.mak

#
# Compiler, assembler, and linker options.
# -g enable symbolic debugging

CC550PTS = -g

AS550PTS =

# -g quiet run

LD550PTS = -g

# Every DSP/BIOS program must be linked with:

# $ (PROG) cfg.o55 - object resulting from assembling
# $ (PROG) cfg.s55

# $ (PROG)cfg.cmd - linker command file generated by
# the Configuration Tool. If additional
# linker command files exist,

# $ (PROG) cfg.cmd must appear first.
#

PROG = volume

OBJS = $(PROG)cfg.obj load.obj

LIBS =

CMDS = $(PROG) cfg.cmd

# Targets:

all:: $(PROG) .out

$ (PROG) .out: $(0OBJS) $(CMDS)
$ (PROG) cfg.obj: $(PROG)cfg.h55
$ (PROG) .0bj :

$ (PROG) cfg.s55 $(PROG)cfg.h55 $(PROG)cfg.cmd:
@ echo Error: $@ must be manually regenerated:
@ echo Open and save $(PROG).cdb within the DSP/BIOS Configuration Tool.
@ check S$Se@

.clean clean::
@ echo removing generated configuration files
remove -f $(PROG)cfg.s55 $(PROG)cfg.h55 $(PROG)cfg.cmd
echo removing object files and binaries
remove -f *.obj *.out *.lst *.map

® ® ®
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2.7 Using DSP/BIOS with the Run-Time Support Library

Table 2-2.

2-22

The linker command file generated by the configuration automatically
includes directives to search the necessary libraries including a DSP/BIOS,
RTDX, and a run-time support library. The run-time support library is created
from rts.src, which contains the source code for the run-time support
functions. These are standard ANSI functions that are not part of the C
language (such as functions for memory allocation, string conversion, and
string searches). A number of memory management functions that are
defined within rts.src are also defined within the DSP/BIOS library. These are
malloc, free, memalign, calloc, and realloc. The libraries support different
implementations. For example, the DSP/BIOS versions are implemented with
the MEM module and therefore make use of the DSP/BIOS API calls
MEM_alloc and MEM_free. Because the DSP/BIOS library provides some of
the same functionality found in the run-time support library, the DSP/BIOS
linker command file includes a special version of the run-time support library
called rtsbios that does not include the files shown in Table 2-2.

Files Not Included in rtsbios

C55x Platform C6000 Platform
memory.c memory.c
boot.c sysmem.c
autoinit.c
boot.c

In many DSP/BIOS projects, it is necessary to use the —x linker switch in
order to force the rereading of libraries. For example, if printf references
malloc and malloc has not already been linked in from the DSP/BIOS library,
it forces the DSP/BIOS library to be searched again in order to resolve the
reference to malloc.

The run-time support library implements printf with breakpoints. Depending
on how often your application uses printf and the frequency of the calls,
printf() can interfere with RTDX, thus affecting real-time analysis tools such
as the Raw Log and Statistics Data, and preventing these tools from
updating. This is because the printf breakpoint processing has higher
priority processing than RTDX. It is therefore recommended to use
LOG_printf in place of calls to printf wherever possible within DSP/BIOS
applications.
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Note:

It is recommended that you use the DSP/BIOS library version of malloc,
free, memalign, calloc and realloc within DSP/BIOS applications. When
you are not referencing these functions directly in your application but call
another run-time support function which references one or more of them,
add '-u _symbol', (for example, -u _malloc) to your linker options. The -u
linker option introduces a symbol, such as malloc, as an unresolved symbol
into the linker's symbol table. This causes the linker to resolve the symbol
from the DSP/BIOS library rather than the run-time support library. If in
doubt, you can examine your map file for information on the library sources
of your application.
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2.8 DSP/BIOS Startup Sequence
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o 8

When a DSP/BIOS application starts up, the calls or instructions in the
autoinit.c and boot.snn files determine the startup sequence. Compiled
versions of these files are provided with the bios.ann and biosi.ann libraries
and the source code is available on the distribution disks received with your
product. The DSP/BIOS startup sequence, as specified in the source code of
the boot files is shown below. You should not need to alter the startup
sequence.

1)

2)

3)

Initialize the DSP. A DSP/BIOS program starts at the C or C++
environment entry point ¢_int00. The reset interrupt vector is set up to
branch to c_int00 after reset.

At the beginning of c_int00 for the C55x platform, the data (user) stack
pointer (XSP) and the system stack pointer (XSSP) are both set up to
point to the bottom of the user and system stacks, respectively.
Additionally, the XSP is aligned to an even address boundary.

For the C6000 platform, at the beginning of ¢_int00, the system stack
pointer (B15) and the global page pointer (B14) are set up to point to the
end of the stack section and the beginning of .bss, respectively. Control
registers such as AMR, IER, and CSR are also initialized.

Initialize the .bss from the .cinit records. Once the stacks are set up,
the initialization routine is called to initialize the variables from the .cinit
records.

Call BIOS_ init to initialize the modules used by the application.
BIOS_init performs basic module initialization. BIOS init invokes the
MOD_init macro for each DSP/BIOS module used by the application.
BIOS init is generated by the configuration and is located in the
programcfg.snn file.

B HWI_init sets up the ISTP and the interrupt selector registers, sets
the NMIE bit in the IER on the C6000 platform, and clears the IFR on
all platforms. See the HWI Module Section in the TMS320 DSP/BIOS
API Reference Guide for your platform for more information.

'Note: When configuring an interrupt, DSP/BIOS plugs in the corresponding '

ISR (interrupt service routine) into the appropriate location of the interrupt
service table. However, DSP/BIOS does not enable the interrupt bit in IER.
It is your responsibility to do this at startup or whenever appropriate during
the application execution.




4)

5)

6)

DSP/BIOS Startup Sequence

B HST init initializes the host I/O channel interface. The specifics
of this routine depend on the particular implementation used for the
host to target link. For example, in the C6000 platform, if RTDX is
used, HST init enables the bit in IER that corresponds to the
hardware interrupt reserved for RTDX.

B IDL_init calculates the idle loop instruction count. If the Auto
calculate idle loop instruction count property was set to true in the Idle
Function Manager configuration, IDL_init calculates the idle loop
instruction count at this point in the startup sequence. The idle loop
instruction count is used to calibrate the CPU load displayed by the
CPU Load Graph (see section 3.8.1, The CPU Load, page 3-45).

Process the .pinit table. The .pinit table consists of pointers to
initialization functions. For C++ programs, class constructors of global
objects execute during .pinit processing.

Call your program’s main routine. After all DSP/BIOS modules have
completed their initialization procedures, your main routine is called. This
routine can be written in assembly, C, C++ or a combination. Because the
C compiler adds an underscore prefix to function names, this can be a C
or C++ function called main or an assembly function called _main.

Since neither hardware nor software interrupts are enabled yet, you can
take care of initialization procedures for your own application (such as
calling your own hardware initialization routines) from the main routine.
Your main function can enable individual interrupt mask bits, but it should
not call HWI_enable to globally enable interrupts.

Call BIOS_start to start DSP/BIOS. Like BIOS _init, BIOS_start is also
generated by the configuration and is located in the programcfg.snn file.
BIOS_start is called after the return from your main routine. BIOS_start
is responsible for enabling the DSP/BIOS modules and invoking the
MOD_startup macro for each DSP/BIOS module. If the TSK Manager is
enabled in the configuration, the call to BIOS_start does not return. For
example:

B CLK startup sets up the PRD register, enables the bit in the IER for
the timer chosen in the CLK Manager, and finally starts the timer.
(This macro is only expanded if you enable the CLK Manager in the
configuration.)

B PIP_startup calls the notifyWriter function for each created pipe
object.

SWI_startup enables software interrupts.

B HWI_startup enables hardware interrupts by setting the GIE bit in the
CSR on the C6000 platform.
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B TSK startup enables the task scheduler and launches the highest
priority task that is ready to run. If the application has no tasks that
are currently ready, the TSK_idle executes and calls IDL_loop. Once
TSK_startup is called, the application begins and thus execution
does not return from TSK_startup or from BIOS_start. TSK_startup
runs only if the Task Manager is enabled in the configuration.

7) Execute the idle loop. You can enter the idle loop in one of two ways. If
the Task Manager is enabled, the Task scheduler runs TSK_idle which
calls IDL_loop. If the Task Manager is disabled, the call to BIOS_start
returns and a call to IDL_loop follows. By calling IDL_loop, the boot
routine falls into the DSP/BIOS idle loop forever. At this point, hardware
and software interrupts can occur and preempt idle execution. Since the
idle loop manages communication with the host, data transfer between
the host and the target can now take place.

2.8.1 Advanced Startup: C5500 Platform Only
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©

On the C5500 platform, the architecture allows the software to reprogram the
start of the vector tables (256 bytes in overall length) by setting the registers
IVPD and IVPH. By default, the hardware reset loads OxFFFF to both these
registers and the reset vector is fetched from location OxFF — FF00. To move
the vector tables to a different location, it is necessary to write the desired
address into IVPD and IVPH after the hardware reset and then do a software
reset, at which time the new values in IVPD and IVPH take effect.

The macro HWI_init loads the configured vector table address into IVPD and
IVPH but must be followed by a software reset to actually bring the new IVPD
and IVPH into effect.
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The C5500 platform also allows for three possible stack modes (see

Table 2-3). To configure the processor in any of the non-default modes, the
user is required to set bits 28 and 29 to the reset vector location appropriately
using the Code Composer Studio debugger tool and then to apply a software
reset. For more information, please see the TMS320C55x DSP CPU
Reference Guide.

Table 2-3. Stack Modes on the C5500 Platform

Stack Mode

Description Reset Vector Settings

2x16 Fast Return

2x16 Slow Return

1x32 Slow Return
(Reset default)

SP/SSP independent,
RETA/CFCT used for fast XX00 : XXXX : <24-bit vector address>
return functionality

SP/SSP independent, . . .
RETA/CECT not used XXO01 : XXXX : <24-bit vector address>
SP/SSP synchronized,

RETA/CECT not used XX02 : XXXX : <24-bit vector address>

In addition, the DSP/BIOS configuration should set the Stack Mode property
of the HWI Manager to match the mode used by the application. See the
TMS320C5000 DSP/BIOS API Reference Guide for details.
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2.9 Using C++ with DSP/BIOS

DSP/BIOS applications can be written in C++. An understanding of issues
regarding C++ and DSP/BIOS can help to make C++ application
development proceed smoothly. These issues concern memory
management, name mangling, calling class methods from configured
properties, and special considerations for class constructors and destructors.

2.9.1 Memory Management

The functions new and delete are the C++ operators for dynamic memory
allocation and deallocation. Within DSP/BIOS applications, these operators
are reentrant because they are implemented with the DSP/BIOS memory
management functions MEM_alloc and MEM_free. However, memory
management functions require that the calling thread obtain a lock to memory
before proceeding if the requested lock is already held by another thread,
blocking results. Therefore, new and delete should be used by TSK objects
only.

The functions new and delete are defined by the run-time support library, not
the DSP/BIOS library. Since the DSP/BIOS library is searched first, some
applications can result in a linker error stating that there are undefined
symbols that were first referenced within the rtsbios (the run-time support)
library. This linker error is avoided by using the -x linker option which forces
libraries to be searched again in order to resolve undefined references. See
Section 2.7, Using DSP/BIOS with the Run-Time Support Library for more
information.

2.9.2 Name Mangling
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The C++ compiler implements function overloading, operator overloading,
and type-safe linking by encoding a function's signature in its link-level name.
The process of encoding the signature into the linkname is referred to as
name mangling. Name mangling could potentially interfere with a DSP/BIOS
application since you use function names within the configuration to refer to
functions declared in your C++ source files. To prevent name mangling and
thus to make your functions recognizable within the configuration, it is
necessary to declare your functions in an extern C block as shown in the code
fragment of Example 2-4.
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Example 2-4. Declaring Functions in an Extern C Block

extern "C" {
Void functionl () ;
Int function2 () ;

This allows you to refer to the functions within the configuration. For example,
if you had an SWI object which should run function1() every time that the SWI
posts, you would use functionl for the function property of that SWI object.

Functions declared within the extern C block are not subject to name
mangling. Since function overloading is accomplished through name
mangling, function overloading has limitations for functions that are called
from the configuration. Only one version of an overloaded function can
appear within the extern C block. The code in Example 2-5 would result in an
error.

Example 2-5. Function Overloading Limitation

extern “C” {

Int addNums (Int x, Int y);

Int addNums (Int x, Int y, Int z); // error, only one version
// of addNums is allowed

}

2.9.3 Calling Class

While you can use name overloading in your DSP/BIOS C++ applications,
only one version of the overloaded function can be called from the
configuration.

Default parameters is a C++ feature that is not available for functions called
from the configuration. C++ allows you to specify default values for formal
parameters within the function declaration. However, a function called from
the configuration must provide parameter values. If no values are specified,
the actual parameter values are undefined.

Methods from the Configuration

Often, the function that you want to reference within the configuration is the
member function of a class object. It is not possible to call these member
functions directly from the configuration, but it is possible to accomplish the
same action through wrapper functions. By writing a wrapper function which
accepts a class instance as a parameter, you can invoke the class member
function from within the wrapper.

A wrapper function for a class method is shown in Example 2-6.
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Example 2-6. Wrapper Function for a Class Method

Void wrapper (SampleClass myObject)

myObject->method () ;

Any additional parameters that the class method requires can be passed to
the wrapper function.

2.9.4 Class Constructors and Destructors
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Any time that a C++ class object is instantiated, the class constructor
executes. Likewise, any time that a class object is deleted, the class
destructor is called. Therefore, when writing constructors and destructors,
you should consider the times at which the functions are expected to execute
and tailor them accordingly. It is important to consider what type of thread will
be running when the class constructor or destructor is invoked.

Various guidelines apply to which DSP/BIOS API functions can be called
from different DSP/BIOS threads (tasks, software interrupts, and hardware
interrupts). For example, memory allocation APIs such as MEM_alloc and
MEM__calloc cannot be called from within the context of a software interrupt.
Thus, if a particular class is instantiated by a software interrupt, its constructor
must avoid performing memory allocation. Similarly, it is important to keep in
mind the time at which a class destructor is expected to run. Not only does a
class destructor execute when an object is explicitly deleted, but also when a
local object goes out of scope. You need to be aware of what type of thread
is executing when the class destructor is called and make only those
DSP/BIOS API calls that are appropriate for that thread. For further
information on function callability, see the TMS320 DSP/BIOS API Reference
Guide for your platform.
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2.10 User Functions Called by DSP/BIOS

e e

User functions called by DSP/BIOS objects (IDL, TSK, SWI, PIP, PRD, and
CLK objects) need to follow specific conventions in order to ensure that
registers are used properly and that values are preserved across function
calls.

On the C6x and C55x platforms, all user functions called by DSP/BIOS
objects need to conform to C compiler register conventions for their
respective platforms. This applies to functions written both in C and assembly
languages.

The compiler distinguishes between C and assembly functions by assuming
that all C function names are preceded by an underscore, and assembly
function names are not preceded by an underscore.

For more information on C register conventions, see the optimizing compiler
user’s guide for your platform.
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2.11 Calling DSP/BIOS APIs from Main
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The main routine in a DSP/BIOS application is for user initialization purposes
such as configuring a peripheral, or enabling individual hardware interrupts.
It is important to recognize that main does not fall into any of the DSP/BIOS
threads types (HWI, SWI, TSK, or IDL), and that when program execution
reaches main, not all of the DSP/BIOS initialization is complete. This is
because DSP/BIOS initialization takes place in two phases: during BIOS _init
which runs before main, and during BIOS _start which runs after your program
returns from main.

Certain DSP/BIOS API calls should not be made from the main routine,
because the BIOS start initialization has not yet run. BIOS start is
responsible for enabling global interrupts, configuring and starting the timer,
and enabling the schedulers so that DSP/BIOS threads can start executing.
Therefore, DSP/BIOS calls that are not appropriate from main are APIs which
assume hardware interrupts and the timer are enabled, or APIs that make
scheduling calls that could block execution. For example, functions such as
CLK_gethtime and CLK_getltime should not be called from main because the
timer is not running. HWI_disable and HWI_enable should not be called
because hardware interrupts are not globally enabled. Potentially blocking
calls, such as SEM_pend or MBX_pend, should not be called from main
because the scheduler is not initialized. Scheduling calls such as
TSK_disable, TSK_enable, SWI_disable, or SWI_enable are also not
appropriate within main.

BIOS _init, which runs before main, is responsible for initialization of the MEM
module. Therefore, it is okay to call dynamic memory allocation functions
from main. Not only are the MEM module functions allowed (MEM_alloc,
MEM_free, etc.), but APIs for dynamic creation and deletion of DSP/BIOS
objects, such as TSK_create and TSK_delete, are also allowed.

While blocking calls are not permitted from main, scheduling calls that make
a DSP/BIOS thread ready to run are permitted. These are calls such as
SEM_post or SWI_post. If such a call is made from main, the readied thread
is scheduled to run after the program returns from main and BIOS_start
finishes executing.

See the TMS320 DSP/BIOS API Reference Guide for your platform for more
information on a particular DSP/BIOS function call. The Constraints and
Calling Context sections indicates if the API cannot be called from main.



Chapter 3

Instrumentation

DSP/BIOS provides both explicit and implicit ways to perform real-time
program analysis. These mechanisms are designed to have minimal impact
on the application’s real-time performance.
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An Overview of Real-Time Analysis

3.1 An Overview of Real-Time Analysis

Real-time analysis is the analysis of data acquired during real-time operation
of a system. The intent is to easily determine whether the system is operating
within its design constraints, is meeting its performance targets, and has
room for further development.

[

Note:

RTDX is occasionally not supported for the initial releases of a new DSP
device or board. On platforms where RTDX is not supported, the RTA tools

in CCSv4 are non-functional.
L ]

3.1.1 Real-Time Versus Cyclic Debugging

The traditional debugging method for sequential software is to execute the
program until an error occurs. You then stop the execution, examine the
program state, insert breakpoints, and reexecute the program to collect
information. This kind of cyclic debugging is effective for non-real-time
sequential software. However, cyclic debugging is rarely as effective in real-
time systems because real-time systems are characterized by continuous
operation, nondeterministic execution, and stringent timing constraints.

The DSP/BIOS instrumentation APIs and the DSP/BIOS Analysis Tools are
designed to complement cyclic debugging tools to enable you to monitor real-
time systems as they run. This real-time monitoring data lets you view the
real-time system operation so that you can effectively debug and
performance-tune the system.

3.1.2 Software Versus Hardware Instrumentation
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Software monitoring consists of instrumentation code that is part of the target
application. This code is executed at run time, and data about the events of
interest is stored in the target system’s memory. Thus, the instrumentation
code uses both the computing power and memory of the target system.

The advantage of software instrumentation is that it is flexible and that no
additional hardware is required. Unfortunately, because the instrumentation
is part of the target application, performance and program behavior can be
affected. Without using a hardware monitor, you face the problem of finding
a balance between program perturbation and recording sufficient information.
Limited instrumentation provides inadequate detail, but excessive
instrumentation perturbs the measured system to an unacceptable degree.

DSP/BIOS provides several mechanisms that allow you to control precisely
the balance between intrusion and information gathered. In addition, the
DSP/BIOS instrumentation operations all have fixed, short execution times.
Since the overhead time is fixed, the effects of instrumentation are known in
advance and can be factored out of measurements.
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3.2 Real-Time Analysis Tools in CCStudio v3.x

DSP/BIOS supports a number of Real-Time Analysis (RTA) tools that are
provided in Code Composer Studio v3.x. These tools provides raw log
information as well as graphs in real-time (while the target is running).

The subsections that follow briefly introduce the RTA tools that are available
in CCSv3.

You may open RTA tools in CCStudio at any time, typically just before
running the target application or while the application is running.

To access the DSP/BIOS analysis tools, use the DSP/BIOS menu in Code
Composer Studio to open any of the following tools. You can also open these
tools by clicking icons in the DSP/BIOS toolbar.

CPU Load Graph. View graph of CPU load.

@ Execution Graph. View graph of information from system log.

Host Channel Control. Bind host files to objects and start data transfer.
@ Message Log. View text messages from user logs.

E Statistics View. View statistics data.

RTA Control Panel. Disable various logging and statistics tracing.

g Kernel Object View. View information about object status.

'Note: If RTDX is disabled, analysis data is updated only in stop mode. That '
is, analysis data is not communicated to the host PC by the idle thread while
the target program is running. When you halt the target or reach a
breakpoint, analysis data is transferred for viewing in Code Composer
Studio.

1

Information about DSP/BIOS modules is available in the following real-time
analysis tools:

Module Tools That Show Information About this Module
BUF BUF in the Kernel Object View shows usage information.
CLK Execution Graph shows clock ticks.

KNL in the Kernel Object View shows the current value of the clock used for timer func-
tions and task sleep alarms.

RTA Control Panel disables CLK logging.
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Module Tools That Show Information About this Module
DEV DEV in the Kernel Object View shows status information.
GBL KNL in the Kernel Object View shows the type of processor.
HST Host Channel Control shows channel binding and activity.
HWI CPU Load Graph shows load consumed by all threads other than IDL threads.
Execution Graph shows HWI execution in the Other Threads row.
RTA Control Panel disables HWI statistics.
Statistics View shows statistics gathered for HWI objects.
IDL Execution Graph shows IDL function execution in the Other Threads row.
LCK No information provided unless program explicitly instruments these objects.
LOG Execution Graph provides a graphical view of system log data.
RTA Control Panel disables implicit logging for SWI, PRD, CLK, and TSK modules.
Property page for the RTA Control Panel sets the polling rate for LOG data.
MBX MBX in the Kernel Object View shows status information.
MEM KNL in the Kernel Object View shows the system stack location, size, and peak usage.
TSK in the Kernel Object View shows stack use by tasks.
MEM in the Kernel Object View shows usage information.
MSGQ MSGQ in the Kernel Object View shows usage information.
PIP RTA Control Panel disables PIP statistics.
Statistics View shows statistics gathered for PIP objects.
PRD Execution Graph shows PRD ticks.
CPU Load Graph shows load consumed by all threads other than IDL threads.
RTA Control Panel disables PRD logging and statistics.
Statistics View shows statistics gathered for PRD objects.
QUE No information provided unless program explicitly instruments these objects.
RTDX See the RTDX help.
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Module

Tools That Show Information About this Module

SEM

SIO

STS

SWwi

TRC

TSK

Execution Graph shows SEM posts.

SEM in the Kernel Object View shows status information.

SIO in the Kernel Object View shows status information.

CPU Load Graph provides a graphical view of data collected by built-in STS objects.

RTA Control Panel disables implicit statistics accumulation for SWI, PRD, PIP, HWI, and
TSK modules.

Property page for the RTA Control Panel sets the polling rate for statistics data.

Statistics View shows statistics gathered by STS objects.

CPU Load Graph shows load consumed by all threads other than IDL threads.

Execution Graph shows SWI execution.

SWI in the Kernel Object View shows status information.

RTA Control Panel disables SWI logging and statistics.

Statistics View shows statistics gathered for SWI objects.

RTA Control Panel disables and enables global tracing and trace bits for various modules.

Property page for the RTA Control Panel sets the polling rate for TRC data set program-
matically.

CPU Load Graph shows load consumed by all threads other than IDL threads.
Execution Graph shows task execution.

KNL in the Kernel Object View lists tasks blocked by timers.

MBX in the Kernel Object View lists tasks blocked by pending or posting on a mailbox.
SEM in the Kernel Object View lists tasks blocked by pending on a semaphore.

TSK in the Kernel Object View shows status information.

RTA Control Panel disables TSK logging and statistics.

Statistics View shows statistics gathered for TSK objects.

Instrumentation 3-5



Real-Time Analysis Tools in CCStudio v3.x

3.2.1 CPU Load Graph

3-6

To display the CPU Load Graph, click the icon or choose the
DSP/BIOS>CPU Load Graph menu item in CCSv3.

In this window, you see a graph of the target CPU processing load. The most
recent CPU load is shown in the lower-left corner and the highest CPU load
reached so far is shown in the lower-right corner. You can resize the graph
by resizing the window.

The CPU load is defined as the amount of time not spent performing the low-
priority task that runs when no other thread needs to run. Thus, the CPU load
includes any time required to transfer data from the target to the host and to
perform additional background tasks.

The CPU load is averaged over the polling rate period. The longer the polling
period, the more likely it is that short spikes in the CPU load is not shown in
the graph. To set the polling rate, open the RTA Control Panel window and
right-click on the window. Choose Property Page from the shortcut menu. In
the Host Refresh Rates tab, set the polling rate with the Statistics View / CPU
Load Graph slider and click OK.

If you right-click on this window, the shortcut menu contains the following
commands:

[ Property Page. There are currently no properties to set for the CPU Load
Graph.

Clear Peak. Set the peak CPU load value to 0%.
Pause. Do not poll the target for CPU load information.

Resume. Begin polling the target for CPU load information.

O dodJd o

Refresh Window. Poll the target for CPU load information one time. This
updates the "Last" value shown in the bottom of the window.

U

Allow Docking. Remove the checkmark next to this item to put this tool
in a separate window you can move to any location on your screen. If the
tool is in a separate window and you select this item, you can drag the
window to any edge of the Code Composer Studio window to dock the
tool.

d Close. Choose this item to hide this tool.

[ Float in Main Window. Put a checkmark next to this item to put this tool
in a separate window you can move to any location within the Code
Composer Studio window.
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3.2.2 Execution Graph

Figure 3-1.

To display the Execution Graph, click the @ icon or choose the
DSP/BIOS>Execution Graph menu item in CCSv3.

The Execution Graph is a special graph used to display information about
SWI, PRD, TSK, SEM and CLK processing. You can enable or disable
logging for each of these object types at run time using the TRC module API
or the RTA Control Panel in the host. Semaphore posts on the Execution
Graph are controlled by enabling or disabling TSK logging. The Execution
Graph window, as shown in Figure 3-1, shows the Execution Graph
information as a graph of the activity of each object.

Execution Graph Window
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|oadPrd
ztepPrd
FHL_zwi

SEM Posts
Other Threads
FRD Ticks
Time
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i Execution Graph

=]
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CLK and PRD events are shown to provide a measure of time intervals within
the Execution Graph. Rather than timestamping each log event, which is
expensive (because of the time required to get the timestamp and the extra
log space required), the Execution Graph simply records CLK events along
with other system events. As a result, the time scale on the Execution Graph
is not linear.

In addition to SWI, TSK, SEM, PRD, and CLK events, the Execution Graph
shows additional information in the graphical display. Assertions are
indications that either a real-time deadline has been missed or an invalid
state has been detected (either because the system log has been corrupted
or the target has performed an illegal operation). The LOG_message state,
which has the color green associated with it, appears on the Assertions trace
line for LOG_message calls made by the user’s application. Errors generated
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by internal log calls are shown in red on the Assertions trace line. Red boxes
on the Assertions trace indicate a break in the information gathered from the
system log.

See section 4.1.5, Yielding and Preemption, page 4-8, for details on how to
interpret the Execution Graph information in relation to DSP/BIOS program
execution.

3.2.3 Host Channel Control

3-8

To display the Host Channel Control window, click the =11 icon or choose
the DSP/BIOS>Host Channel Control menu item in CCSv3.

In this window, you see the host channels defined by your program. You can
use this window to bind files to these channels, start the data transfer over a
channel, and monitor the amount of data transferred.

You can resize the widths of the columns in the Host Channel Control by
dragging the dividers between the column headings.

If you right-click on the name of a channel in this window, the shortcut menu
contains the following special commands:

@ Bind. Choosing this command opens a window that lets you select a file
on the host to bind to this channel.

B For an input channel, select a file that already exists. The contents of
the file are read and transferred to the target.

B For an output channel, you can select a filename that does not exist.
If you select a file that already exists, Code Composer asks if it is OK
to overwrite this file. The target uses the host channel to write data to
this file. You can set a limit on the number of kilobytes to be written
to this file when you bind the channel.

@ Unbind. Choosing this command unbinds the file from this channel. You
can then select another file to bind the channel to.

[ Start. Choosing this command notifies the target that data is ready to be
read from an input channel or that a file is ready to receive data from an
output channel. If you highlight multiple channels, you can start them all
at the same time.

[ Stop. Choosing this command stops the data transfer over this channel.
If you highlight multiple channels, you can stop them all at the same time.
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To display a Message Log window, click the @ icon or choose the
DSP/BIOS>Message Log menu item in CCSv3.

: DSP/BIDS Message Log IS I=] E3
Log Mame: Itrau:e vI

hello world!

period 1: time = 2000
period |: tirme = 4000
period 1: time = GO00
period 1: time = 8000
period 1: tirme = 10000
peniod 1 tirme = 12000

ol O T e D O —

You can view log messages or write log messages to a file. To control how
often data in this window is updated, you can set the polling rate. Select the
log you want to view from the Log Name list. If you select Execution Graph
Details, the messages written to the system log are shown.

When you run the program, log messages are shown in this window
whenever the host PC gets DSP/BIOS data from the target. Explicit log
messages written by your program are shown even if you disable logging in
the RTA Control Panel window.

If you right-click on a Message Log window, the shortcut menu contains the
following special commands:

M
a

Property Page. Allows you to store log messages in a file.

Pause. Do not poll the target for information in this log (unless you
choose Refresh Window from the shortcut menu).

Resume. Begin polling the target for information in this log at the rate set
in the Properties window for the RTA Control Panel.

Refresh Window. Poll the target for information in this log one time.

Clear. Erase the messages displayed in this window. (This has no effect
on the messages stored in the log on the target.)

Copy. Copy the selected text in this window to the clipboard. You can
then paste the text into another application.

Select All. Highlight all the text in this window. You can then choose
Copy from the shortcut menu. (You can only use Select All when this
window is paused or the program is not running.)

Automatically scroll to end of buffer. When checked, the Message Log
scrolls to the last message received whenever the target is polled. When
unchecked, the Message Log does not scroll automatically.
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3.2.5 Statistics View

To

display the Statistics View, click the E icon or choose the

DSP/BIOS>Statistics View menu item in CCSv3.

i Statistics Yiew _ (O]
5TS Count T atal b & Average
loadPrd 193 0 1] 0
stepFrd 1 1] 0 1]
PRO_swi 1931 F1200064.00 inst 10257200 inst 3BEF212 inst
FML_swi 16453 813010280.00 inst 102764.00 inst 5261.18 inst
audioS wi 1287 2B93364.00 inst F236.00 inst 2092.75 inst
IDL_bugyObj E35923 1217 1 0007191374

The statistics gathered for each object type represent different values and
have different units. The statistics measured for these objects are as follows:

4

3-10

STS. Using the STS module API functions, an STS object can gather
statistics for any value you like. By setting the STS object properties, you
can also apply a formula and a printf-style format to the STS data values
on the host. In the Units tab, you can type any unit label.

PIP. Counts the number of frames read from or written to a data pipe. In
the Units tab, you can type any unit label.

PRD. Reports statistics on th